OPERATION AND PROGRAMMING
INSTRUCTION MANUAL

Ω mega_FM

DIGITAL FM-AIRCHAIN PROCESSOR

Ω

Rev. 2

INOVONICS INCORPORATED

interstage
pro audio with a smile
OPERATION AND PROGRAMMING
INSTRUCTION MANUAL

Ωmega_FM

DIGITAL FM-AIRCHAIN PROCESSOR

August, 2002
(Rev. 2 Software)
# TABLE OF CONTENTS

## Section I - INTRODUCTION
- OMEGA_FM PRODUCT DESCRIPTION ................................................................. 4  
  General • Simplified Use • User Programming • Features
- OMEGA_FM TECHNICAL SPECIFICATIONS ..................................................... 5
- BLOCK DIAGRAM ............................................................................................ 7

## Section II - INSTALLATION
- UNPACKING AND INSPECTION ......................................................................... 8
- MOUNTING ......................................................................................................... 8
  - Rack Requirement • Heat Dissipation
- AC (MAINS) POWER ......................................................................................... 9
  - Power Supply • Mains Voltage Selector • Power Cord
- RADIO FREQUENCY INTERFERENCE (RFI) ...................................................... 9
  - Location • Ground Loops
- PROGRAM INPUT CONNECTIONS AND SWITCHING ....................................... 9
  - INPUT MODE Switch • Analog Input Connections
  - Unbalanced Operation • Gain Range Jumpering
  - Digital Input Connections • AES/EBU and S/PDIF Selection
  - Digital Input Gain
- PROGRAM OUTPUT CONNECTIONS ................................................................ 11
  - Line Output Frequency Characteristic
  - Analog Line Outputs • Digital Outputs
- MPX OUTPUT CONNECTION ............................................................................ 12
- SETTING PRE-EMPHASIS ................................................................................ 12
- RS-232 PROGRAMMING PORTS ....................................................................... 13
  - Front Panel Programming Port • Rear Panel Modem Port

## Section III - BASIC SETUP AND OPERATION
- FRONT PANEL LOCKOUT .................................................................................. 14
- BASIC SETUP WITH ANALOG PROGRAM INPUTS ........................................... 14
  - Connection • Input Selection • Software Input Gain Note
  - Setting Levels (General) • Setting With Program • Setting With Tones
- BASIC SETUP WITH DIGITAL PROGRAM INPUTS .......................................... 15
  - Connection and Input Selection • Input Level Adjustment
  - L/R INPUT Metering • Setting Levels (General)
  - Setting With Program • Setting With Tones • Software Gain Warning
- COMPOSITE/MPX OUTPUT LEVEL AND ADJUSTMENT ............................... 17
  - Processing Setup• Maximum Carrier Deviation
Section IV - SOFTWARE MANAGEMENT

<table>
<thead>
<tr>
<th>INSTALLING THE SOFTWARE</th>
<th>19</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Procedure • Desktop Icon</td>
<td></td>
</tr>
<tr>
<td>STARTING THE SOFTWARE</td>
<td>20</td>
</tr>
<tr>
<td>Communications</td>
<td></td>
</tr>
<tr>
<td>PASSWORD MANAGEMENT</td>
<td>21</td>
</tr>
<tr>
<td>Changing the First-Level Password</td>
<td></td>
</tr>
<tr>
<td>Super Password • Retrieving Lost Passwords</td>
<td></td>
</tr>
<tr>
<td>CLOSING THE PROGRAM</td>
<td>22</td>
</tr>
<tr>
<td>Log On / Log Off</td>
<td></td>
</tr>
<tr>
<td>FIRMWARE</td>
<td>23</td>
</tr>
<tr>
<td>Firmware Installation</td>
<td></td>
</tr>
</tbody>
</table>

Section V - CONTROLLING THE PROCESSOR

<table>
<thead>
<tr>
<th>SETUP</th>
<th>24</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Setup • Modem Setup • Files and Paths • Install</td>
<td></td>
</tr>
<tr>
<td>MPX Setup • L/R Input Setup • L/R Output Setup</td>
<td></td>
</tr>
<tr>
<td>Signal Generator • Format Converter</td>
<td></td>
</tr>
<tr>
<td>PASSWORD</td>
<td>28</td>
</tr>
<tr>
<td>CONTROLS</td>
<td>29</td>
</tr>
<tr>
<td>Navigating the Controls • Computer Screen Resolution</td>
<td></td>
</tr>
<tr>
<td>“Format” • Defining Custom Formats</td>
<td></td>
</tr>
<tr>
<td>“Format” Box Options • “AGC” • AGC Time Constants</td>
<td></td>
</tr>
<tr>
<td>“Gate” • Advanced AGC Controls • Parametric EQ”</td>
<td></td>
</tr>
<tr>
<td>“Multiband” • Bass Enhance • “Limiter” • “MPX” • “Other”</td>
<td></td>
</tr>
<tr>
<td>REMOTE CONTROL</td>
<td>36</td>
</tr>
<tr>
<td>DAYPARTING</td>
<td>36</td>
</tr>
<tr>
<td>Synchronizing the Clocks • Creating and Editing Daypart Entries</td>
<td></td>
</tr>
<tr>
<td>Daypart On/Off Saving Schedules</td>
<td></td>
</tr>
<tr>
<td>Fetching and Sending Schedules • Priorities</td>
<td></td>
</tr>
<tr>
<td>PROCESSING TIME CONSTANTS EXPLAINED</td>
<td>39</td>
</tr>
<tr>
<td>OMEGA_FM CONTROL SCREEN OPTIONS</td>
<td>39</td>
</tr>
<tr>
<td>Appearance • Input Metering</td>
<td></td>
</tr>
<tr>
<td>• Leveling, Compression and Limiting Meters • Output Metering</td>
<td></td>
</tr>
</tbody>
</table>

Section VI - CUSTOMIZING PROCESSOR SETTINGS

<table>
<thead>
<tr>
<th>GENERAL</th>
<th>42</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup • Program Source • Monitors • Setting Your Goals</td>
<td></td>
</tr>
<tr>
<td>‘SOFTWARE SLIDER’ BASICS</td>
<td>44</td>
</tr>
<tr>
<td>HOW TO START</td>
<td>44</td>
</tr>
<tr>
<td>WHAT TO ADJUST FIRST – ‘ROUGHING-IN’</td>
<td>44</td>
</tr>
<tr>
<td>AGC Level • Parametric EQ • Leveling</td>
<td></td>
</tr>
<tr>
<td>Compression • Bass Enhance • Limiting</td>
<td></td>
</tr>
<tr>
<td>FINE-TUNING OMEGA_FM PROCESSING ADJUSTMENTS</td>
<td>46</td>
</tr>
</tbody>
</table>
Section VII - REMOTE CONTROL VIA MODEM

CONNECTING THE MODEM ................................................................. 60
Recommended Modem • Checking Modem Communications

SETTING UP COMPUTER COMMUNICATIONS ........................................ 61
Port Assignment • Modem Communication Speed
Phone Number

Appendix .................................................................................................. 65
Processor Setup Worksheets • SBC Jumper Positions
Inovonics Warranty
Section 1
INTRODUCTION

OMEGA_FM PRODUCT DESCRIPTION

General
Inovonics’ Omega_FM is a digital audio processor and FM-stereo encoder for commercial VHF broadcasting. Omega_FM differs from other digital broadcast processors in that it uses all-digital signal processing techniques performed entirely in software.

Omega_FM offers the following audio processing functions with independently-adjustable parameters:

- Slow, ‘gain-riding’ AGC
- 4 independent sections of state-variable parametric equalization
- Psycho-acoustic bass enhancement
- 4-band spectrum-consistency leveling
- 4-band dynamic range compression and graphic equalization
- Independent wideband and high-frequency program peak control
- Adjustable composite clipping with spectrum filtering option

The composite/MPX FM-stereo baseband is generated digitally as well. The baseband includes the 19kHz stereo pilot and the 38kHz suppressed-carrier difference-signal component.

The Omega_FM performs its ‘number-crunching’ chores using a fast, full-function, internal single-board computer (SBC) mated with a pair of proprietary Inovonics analog/digital I/O interface boards.

Simplified Use
The Omega_FM is delivered with a preinstalled set of versatile factory-programmed processing presets to facilitate quick installation and immediate “no menu” setup and operation without need for a computer. These perceptive factory presets can satisfy nearly any station programming format requirement, making user reprogramming seldom necessary.

User Programming
Nonetheless, processing may be placed under external computer control for full access to the frequency, level and timing adjustments that define the various processing parameters. Any Pentium®-class PC is suitable for use with Omega_FM, assuming sufficient memory and video acceleration.
Processing parameter changes and most other adjustments to the Omega_FM may be made ‘on-air’ without interrupting the program signal. User-defined processing settings made by PC interface are uploaded to the Omega_FM’s non-volatile memory.

Features

Leading features of the Omega_FM include:

- A simplified ‘total-software’ approach to digital processing. This means a very short effective signal path giving clean audio with minimal latency (signal delay).
- Processing is performed entirely within the digital domain without application-specific DSP chips or modules. No hardware upgrades are necessary for future updates.
- Both digital and analog inputs and outputs allow the Omega_FM to interface with new or existing station audio and transmission equipment.
- A built-in Scheduler is included for “dayparting” (automatic processing changes to a predetermined time schedule).
- The front panel of the Omega_FM is simple and uncluttered. There are only four pushbutton switches... no ‘softkeys,’ jogwheels or multiple, scrolling menus. The front panel LED display is bright and easy to read, even at a distance.

OMEGA_FM TECHNICAL SPECIFICATIONS

**NOTE:** Performance measurements reflect the worst case of any in/out configuration; that is, analog or digital inputs to analog, digital or composite/MPX outputs.

**Frequency Response:**
±0.5dB, 20Hz–15kHz.

**Distortion:**
<0.05%THD, 20Hz–4kHz;
<0.25% above 4kHz

**Noise:**
Better than 75dB below full modulation.

**Stereo Separation:**
Better than 60dB.

**Stereo Crosstalk** (M/S or S/M):
Better than –60dB.

**Preemphasis:**
75µs, 50µs or 0 (flat).

**Processing Sampling Rate:**
48kHz.

**Latency** (Program Signal Delay):
10.5ms.

**Boot Time** (Power-On to Operate):
<3sec.

**Digital Inputs:**
AES/EBU balanced (XLR); S/PDIF unbalanced (BNC). Automatic synchronization at 32kHz, 44.1kHz and 48kHz digital audio sampling rates.
Analog Inputs (Left and Right):
  Active-balanced (XLR), >10k-ohms bridging; accept nominal program levels between –15dBu and +15dBu.

Digital Output:
  AES/EBU balanced (XLR); S/PDIF unbalanced (BNC); 48kHz Sampling Rate.

Analog Outputs (Left and Right):
  Active-balanced (XLR), <100-ohm source impedance; adjustable to deliver 0dBm to +15dBm into 600 ohms or greater.

Composite/MPX Output:
  Unbalanced (BNC), 50-ohm source impedance; adjustable between 0.5Vp-p and 5.5Vp-p, corresponding to ±75kHz carrier deviation.

Stereo Pilot:
  19kHz, ±1Hz; injection adjustable between zero and 20% relative to ±75kHz carrier deviation.

Programming Data Ports:
  a) Front-panel RS-232 female for direct connection to computer COM (serial) port with a simple ‘serial extension’ cable (supplied). Permits parameter programming and firmware updating by the user.
  b) Rear-panel RS-232 male for connection to US Robotics-compatible modem for off-site remote control.

Front Panel Controls:
  a) ▼ ▲ SIGNATURE buttons select from 3 factory format presets (Aggressive, Smooth, Natural), and one user-defined (Custom) preset
  b) ▼ ▲ PROCESSING buttons select program density (Heavy, Medium, Light), which can be applied to any selected signature format.

Rear Panel Controls:
  a) Front Panel Lockout switch (ON or OFF).
  b) Input Mode selector (Analog or Digital).
  c) Digital Input selector (AES/EBU or S/PDIF).
  d) Input Level Adjust (multiturn manual adjustments for L/R Analog Input).
  e) Output Level Adjust (multiturn manual adjustments for the L/R Analog Output).
  f) MPX Level Adjust (multiturn manual adjustment for the composite/MPX output).
  g) Mains Voltage Selector (115V or 230V)

Power Requirements:
  105–130VAC or 210–260VAC, 50/60Hz; 90 watts.

Size and Weight:
  3½”H x 19”W x 12”D (2U);
  14 lbs. (shipping).
The Block Diagram has traditionally proven a valuable aid in understanding any electronic circuit or system. In the case of a product such as the Omega FM, however, the audio processing and other functions are reduced to a series of mathematical manipulations driven by a software ‘instruction set.’ A block diagram showing the actual large-scale-integration elements and digital bus architecture would be of little help in explaining how the Omega FM works.

Instead, an Equivalent Block Diagram is presented here. It has been drawn as if the Omega FM were an analog processing system. This clearly shows what the Omega FM does, but not actually how it does it.

Figure 1 - Equivalent Block Diagram, Omega FM
Section II
INSTALLATION

UNPACKING AND INSPECTION

Immediately upon receiving the equipment, please make a careful inspection for any shipping damage. If damage is found or suspected, notify the carrier at once, and then contact Inovonics. We recommend that you retain the original shipping carton and packing materials in case return or reshipment becomes necessary. In the event of return for Warranty repair, shipping damage sustained as a result of improper packing for return may invalidate the Warranty!

**IT IS VERY IMPORTANT** that the Warranty Registration Card found at the front of this Manual be completed and returned directly to Inovonics. Not only will this assure coverage of the equipment under terms of the Warranty, and provide a means for tracing lost or stolen gear, but the user also will automatically receive specific SERVICE OR MODIFICATION INSTRUCTIONS and SOFTWARE UPDATES when they are issued.

MOUNTING

**Rack Requirement**

The Omega_FM mounts in a standard 19-inch equipment rack and requires only 3½ inches (2U) of vertical rack space. Plastic ‘finishing’ washers are recommended to protect the painted finish around the mounting holes.

**Heat Dissipation**

Consuming about as much power as an old IBM Selectric® typewriter, the Omega_FM itself generates only a moderate amount of heat. Three internal cooling fans maintain the internal chassis temperature close to the outside ambient, and the unit is specified for operation within an ambient temperature range extending from freezing to 120°F, or 50°C. Heat from adjacent equipment must be factored into the installation, however; make sure that the equipment rack is adequately ventilated and that its internal temperature does not exceed the specified maximum ambient.
AC (MAINS) POWER

Power Supply  The Omega_FM has neither a mains power switch nor a rear-panel mains primary fuse. It uses a sealed, protected and shielded switching-type power supply that is qualified and certified for safety and EMI suppression in accordance with the requirements of highly esteemed, worldwide standards organizations.

Mains Voltage Selector  Unless specifically ordered for export shipment, the Omega_FM is set at the factory for operation from 115V, 50/60Hz AC mains. A clearly marked slide switch above the rear-panel AC mains connector selects 115VAC or 230VAC operation.

**BE SURE** to check the position of the mains voltage selector switch before plugging the Omega_FM into the wall socket!

Power Cord  The detachable IEC-type power cord supplied with the Omega_FM is fitted with a North American-standard male plug. Nonetheless, the individual cord conductors are supposed to be color-coded in accordance with CEE standards; that is:

- BROWN = AC “HOT”
- BLUE = AC NEUTRAL
- GRN/YEL = EARTH GROUND

If this turns out not to be the case, we offer our apologies (cords come from many and diverse sources) and advise that US color coding applies:

- BLACK = AC “HOT”
- WHITE = AC NEUTRAL
- GREEN = EARTH GROUND

RADIO FREQUENCY INTERFERENCE (RFI)

Location  The Omega_FM is designed to operate alongside high-power RF gear and is equipped with appropriate input and output filtering. Nonetheless, do practice reasonable care and common sense in locating the unit away from abnormally high RF fields.

Ground Loops  Because the inputs and the outputs of the Omega_FM are referenced to chassis ground, a mains frequency or RF ground loop could be formed between input or output cable shield grounds and the AC power cord ground. A ‘ground-lifting’ AC adapter may well remedy such a situation, though the chassis somehow must be returned to local earth ground for safety considerations.

PROGRAM INPUT CONNECTIONS AND SWITCHING

INPUT MODE Switch  An INPUT MODE switch is located on the Omega_FM rear panel. It selects between ANA. (analog) and DIG. (digital) program inputs.
NOTE: This INPUT MODE switch must be set to the position appropriate to the input source.

Analog Input Connections
Two rear-panel XLR connectors accept line-level analog inputs. These ANALOG INPUTS are labeled LEFT and RIGHT, and are electronically balanced, high impedance ‘bridging’ inputs for program lines with a nominal “zero-VU” reference level between –15dBu and +15dBu. Internal jumpers split the 30dB input level range into more manageable 15dB segments. Two multi-turn INPUT LEVEL ADJUST controls allow the user to set circuit gain within the 15dB windows.

As delivered, the Omega_FM is jumpered for professional high level program lines with “zero VU” levels between 0dBu and +15dBu. The unit is factory-preset for a reference level of +4dBu.

Unbalanced Operation
If the analog program source is a single-ended (unbalanced) connection, the central ‘hot’ lead of each shielded cable should go to pin 2 of the XLR input connectors, and the cable shield tied both to pin 1 and to pin 3.

Gain Range Jumpering
Gain jumpers are beneath the top cover of the Omega_FM. The cover may be lifted after first removing eight screws from the top of the unit and six screws along the upper edges of the two side panels.

Referring to Figure 2, below, locate the jumper group JP401 behind the XLR input connectors on the upper Analog Board. A jumpering guide is silkscreened on the board adjacent to JP401 and reproduced in Figure 2 here as well.

Figure 2 – Analog LINE INPUT Range Selection

For high-level program lines in the 0dBu to +15dBu range (most frequently encountered in professional installations), the four jumpers should be set as shown in the right frame of Figure 2. The Omega_FM is jumpered at the factory for high level inputs and adjusted at the factory for a zero-VU input line level of +4dBu.

For line levels in the Low Level range, between –15dBu and 0dBu, install the four jumpers as shown in the left frame.

NOTE: Except for pre-emphasis jumpering (see Pages 12 and 13), the four jumpers associated with JP401 are the only circuit-board jumpering options pertinent to Omega_FM operation. Jumper(s on
the SBC board must be left as supplied! A guide to the proper position of these jumpers is nonetheless included in the Appendix at the back of this Manual; some people just have to mess with these things.

**Digital Input Connections**

The Omega FM accommodates both the professional AES/EBU (balanced) digital program line standard and the S/PDIF (unbalanced) standard frequently used in portable and consumer equipment. These two standards embrace a common data formatting specification that encodes both channels of the stereo pair into a single serial data stream. The Omega FM synchronizes automatically with 32kHz, 44.1kHz and 48kHz digital audio sampling rates.

The AES/EBU input is an XLR female connector toward the lower left-hand corner of the Omega FM rear panel. This is a transformer-isolated, ‘floating’ balanced input.

The S/PDIF input is a BNC connector with chassis-ground reference.

**AES/EBU and S/PDIF Selection**

A rear-panel switch selects either the AES/EBU or the S/PDIF input. 

**NOTE:** Both the DIGITAL INPUT switch and the INPUT MODE switch must be set appropriately for the input source.

**Digital Input Gain**

Because digital program lines normally conform to established level standards, and also in recognition of the unusually broad capture range of the Omega FM AGC, there is seldom any need to adjust digital input gain. Nonetheless, a setup routine in the Omega FM software does allow for software adjustment of input gain.

The factory-programmed, default software setting of input gain is 0dB or “wide open.” This maintains maximum headroom in the analog input stages that share the variable software control. This is also an acceptable setting for inputs from digital consoles that have allowed adequate margin for program headroom. Pre-compressed digital inputs may require a lower software setting. This is discussed on Pages 15 through 17.

**PROGRAM OUTPUT CONNECTIONS**

**NOTE:** Both the analog and the digital program line outputs are always active. No switching between these is required, as is the case with Omega FM inputs.

**Line Output Frequency Characteristic**

The frequency characteristic common to both the analog and the digital program line outputs can assume either a flat frequency response, or in the “FM Mode” it can follow a selected pre-emphasis curve, with or without subsequent de-emphasis. The choices are discussed on Pages 25 through 27, and are selected with a software setup command.

The factory-default setting is the “FM Mode” with de-emphasis engaged. This yields a signal with a flat frequency characteristic,
but with an output ceiling that follows the inverse of the pre-emphasis curve. If this signal is again pre-emphasized in an external stereo generator or digital FM exciter, the transmitted signal will have proper pre-emphasis and spectral protection.

**Analog Line Outputs**  
The Omega_FM has active-balanced LEFT and RIGHT channel, line-level ANALOG OUTPUTS for applications requiring discrete L/R processed audio. These male XLR connectors are located to the right of the ANALOG INPUTS on the Omega_FM rear panel.

L (left) and R (right) OUTPUT LEVEL ADJUST controls are adjacent to the ANALOG OUTPUTS. These are multi-turn potentiometers that vary the analog level over a 15dB range. With the “wide open” factory-preset, default setting of the software output level, the ANALOG LINE OUTPUTS are adjustable between 0dBu and +15dBu. (Software control of the Output Level is discussed on Pages 25 and 26.)

**Digital Outputs**  
The Omega_FM has both a balanced AES/EBU digital OUTPUT (XLR) and an unbalanced S/PDIF OUTPUT (BNC). These two connectors are adjacent to the corresponding inputs.

The factory-preset, default software setting of the output level takes the strictly limited output characteristic of the Omega_FM into consideration. It leaves scant margin between the output ceiling and “digital full scale,” or 0dBFS. For headroom considerations in other equipment, the digital program line output level may need to be reduced. Software control of the output level is discussed on Pages 25 and 26.

**MPX OUTPUT CONNECTION**

The Omega_FM provides the composite, multiplexed FM stereo baseband signal from a rear-panel BNC connector. This MPX OUTPUT is unbalanced and is chassis-ground-referenced.

The connection between the MPX OUTPUT and input to the FM exciter or ‘composite link’ to the transmitter site (STL) should be kept as short as practicable to maintain best stereo separation and freedom from noise pickup.

The MPX LEVEL ADJUST control is a multi-turn potentiometer adjacent to the output connector. This varies the level of the baseband signal between 0.5Vp-p and 5.5Vp-p, corresponding to 100% modulation (±75kHz deviation) of the FM carrier.

**SETTING PRE-EMPHASIS**

The Omega_FM is delivered with pre-emphasis selection appropriate to the delivery destination. This will be the 50-microsecond characteristic for Europe and most of Asia, and the 75-microsecond curve for the Americas and most of the Pacific Rim.
Pre-emphasis is set with a jumper beneath the top cover of the Omega_FM. The cover may be lifted after first removing eight screws from the top of the unit and six screws along the upper edges of the two side panels.

The jumper strip is located along the upper edge of the front-panel (display) board, just behind the USER CONTROL area. Figure 3 is a view looking down into the Omega_FM. This shows the location of the jumpers for the three pre-emphasis options. The jumper positions are also identified with barely-discernable lettering in the copper layer of the exposed side of the circuit board, just below the jumper strip.

![Figure 3 - Pre-Emphasis Selection Jumpering](image)

**NOTE:** If the Omega_FM is running under computer or modem (remote) control, close the program or temporarily disconnect the serial interface cable while making pre-emphasis jumper changes.

### RS-232 PROGRAMMING PORTS

**Front Panel Programming Port**

A DB-9 female connector is located on the Omega_FM front panel for convenience in loading the user-defined Custom processing presets. This also is used for installing firmware updates and factory processing presets, and for making other processing adjustments under software control. Use the 9-pin, pin-for-pin serial extension cable supplied with the Omega_FM to connect this front-panel port with the selected COM port of the controlling PC. The adjacent Program indicator will light when communication has been established with the connected computer.

Section V of this Manual details computer connection, processor programming and software management.

**Rear Panel Modem Port**

A DB-9 male connector is located on the Omega_FM rear panel. Effective with the Rev. 2 software release, this rear-panel connector allows dial-up modem remote control of the Omega_FM.

Section VII of this Manual contains instructions and details for installing and using an external modem for full remote control of the Omega_FM.
Section III

BASIC SETUP AND OPERATION

Follow these first, very basic setup procedure to get the Omega_FM up and running quickly, right out of the box, without the need for a computer or any test equipment.

The procedures outlined in this Section assume a typical installation with professional analog or digital inputs, and the composite/MPX output of the Omega_FM cabled directly (or via a ‘composite STL’) to the wideband input of the FM exciter.

FRONT PANEL LOCKOUT

A switch on the back panel of the Omega_FM prevents accidental bumping or tampering with the front-panel USER CONTROL buttons. This switch is labeled FRONT PANEL LOCKOUT and renders the buttons inactive when it is in the ON position.

BASIC SETUP WITH ANALOG PROGRAM INPUTS

Connection

Refer to input connection, switching and gain-range jumpering instructions on Page 10. Line-level, balanced program inputs are connected to the rear-panel XLR LEFT and RIGHT channel ANALOG INPUTS.

Input Selection

Be sure that the INPUT MODE switch is set to ANA. (Analog).

Software Input Gain Note

NOTE: When using analog program sources, it is essential that the Omega_FM software-controlled L/R Input Setup (gain) setting is at the factory-programmed, default value of 0dB, or ‘wide open.’

NOTE: If any changes have been made to the factory-default software settings, or if the Omega_FM has seen previous service with digital program inputs, check that the software input gain slider has been reset to 0dB. Read the Software Gain Warning on Page 17, and refer to Section V for accessing this software control. Software installation and use is described in Section IV.

Setting Levels (General)

The analog INPUT LEVEL ADJUST controls are adjacent to the ANALOG INPUTS on the rear panel of the Omega_FM. These may be set either with normal program material or with a 1kHz test tone from the studio console.
Dynamics of the program material, console meter ballistics, and operator habits and practices will obviously have a direct bearing on the input gain setting of the Omega FM. Nevertheless, the following guidelines will prove effective in nearly all situations.

**Setting With Program**

With normal program material from the console feeding the Omega FM, set the rear-panel L (Left) and R (Right) INPUT LEVEL ADJUST controls so that the indicated-and-held ‘peak’ value of the program hovers just at the –6dB mark on the front-panel INPUT meters. When set optimally, recorded music peaks should only occasionally exceed the –6dB point (most recorded music is already well-limited). Live voice announcements, on the other hand, may peak a few dB higher than music. The LEFT and RIGHT front-panel INPUT meters should track, both for the held peak value and for the average value of the program material, to the extent that this can be determined visually. When the input gain is properly adjusted, the AGC meter will hover within a couple of segments (±4dB) of the 0dB, center-scale point.

**Setting With Tones**

With a 1kHz test tone from the console, set console faders so that console meters indicate “Zero-VU,” PPM 4, or a corresponding meter reference point for steady-state tones. Adjust the Omega FM rear-panel L and R INPUT LEVEL ADJUST controls so that front-panel INPUT metering reads –16dB for both channels. At this setting the AGC meter should settle at a reading of +6dB AGC gain.

After setting levels with tones, reapply the normal program. The front-panel INPUT meters should match the criteria set forth under the previous heading, Setting With Program. If this turns out otherwise, make mental note of the discrepancy, re-apply tones from the console, and then reset INPUT GAIN with the proper offset. For example, if the program consistently peaks at –4dB, rather than the expected –6dB, reset the “Zero-VU” tones 2dB lower, or –18dB on the LEFT and RIGHT front-panel meters.

---

**BASIC SETUP WITH DIGITAL PROGRAM INPUTS**

**Connection and Input Selection**

When the Omega FM is operated with digital inputs, the INPUT MODE switch must be set to the DIG (Digital) position.

Connect AES/EBU or S/PDIF digital inputs to the similarly-marked connectors on the rear panel of the Omega FM. Set the DIGITAL INPUT switch to the appropriate position for the input used.

**Input Level Adjustment**

Input gain for digital program inputs is adjustable only under software control using a computer. Section IV, starting on Page 19, gives the procedure for loading Omega FM software onto a PC and for establishing communications between the computer and the Omega FM.

**L/R INPUT Metering**

In the case of digital program inputs, the LEFT and RIGHT channel INPUT meters always indicate the raw, uncorrected peak level of the input signal. +10dB (full-scale) on these meters corresponds to
‘digital full scale,’ or 0dBFS. Keep in mind that software adjustment of input gain will make no difference in the INPUT meter indication.

Dynamics of the program material, console meter ballistics, operator practices and habits, and headroom allowances throughout the digital audio chain will obviously have a direct bearing on the input gain setting of the Omega_FM.

Because a digital program line has a finite dynamic range, program peak levels must be held to stricter tolerances than in the analog domain to avoid program waveform clipping. The default “0dB” software input level setting of the Omega_FM will give satisfactory results under conditions that have allowed a sufficient margin for headroom. Such inputs will peak in the –10dB to –4dB range on the LEFT and RIGHT channel INPUT meter scales.

Digital inputs that have been subjected to pre-processing may well exhibit frequent peaks above 0dB as viewed on the L and R Input metering bargraphs. Under these circumstances, the factory-default, 0dB setting of the software Gain adjustment will have to be adjusted downward for digital inputs.

**NOTE:** If software Gain adjustment proves necessary at this point, refer to Section IV (Page 19) for installing and running the Omega_FM software.

With Omega_FM software running, go to Setup→Input Setup, type in the Super (supervisory) Password when prompted. This will make the Input Setup adjustment panel accessible as shown below.
**Setting With Program**

Using the mouse, adjust the software Gain slider to maintain a mid-scale (0dB) AGC meter reading for the predominance of program material. (Remember that the L and R Input level displays will not reflect changes made under L/R Input Setup.) If, for instance, the unadjusted AGC gain consistently hovers around –6dB, pull the software Gain slider down 6dB from its present value.

Keep in mind that Omega_FM AGC action is a slow, “gain-riding” function. It may take a few seconds for the AGC indicator to stabilize after the Gain slider has been moved. Don’t rush this adjustment.

**Setting With Tones**

Because there are no individual channel adjustments to upset stereo balance, the Setting With Program routine is both the preferred and the easiest method for setting Omega_FM input gain with digital program inputs. Stubborn operators may nonetheless use test tones as follows.

With a 1kHz test tone feeding the console, set console faders so that console meters indicate “Zero-VU,” PPM 4, or an equivalent meter reference point for steady-state tones. Adjust the Setup→Input Setup software Gain slider so that Omega_FM AGC meter reads +6dB. (Remember that the L and R Input level displays show the absolute level of the digital input signal and will not reflect changes made to the software Gain slider.)

Once input gain has been set with tones, the Omega_FM AGC meter indication should match the criteria set forth under the previous heading, Setting With Program. If the AGC meter tends to wander more than a couple of segments (±4dB) from center-scale as it processes typical program material, reset software Gain with an appropriate correction factor. For example, if the program maintains AGC gain around –4dB, move the control down 4dB.

**Software Gain Warning**

**NOTE:** It is very important to reset the Setup→L/R Input Setup software Gain control to the factory-default value of 0dB before using the Omega_FM with analog inputs. Failure to follow this warning will compromise analog input stage headroom and hopelessly confuse the poor soul trying to follow the Manual’s setup procedure for analog program lines!

---

**COMPOSITE/MPX OUTPUT LEVEL ADJUSTMENT**

This adjustment is made with normal program material feeding the Omega_FM, and with the MPX OUTPUT connector on the rear panel cabled to the wideband input of the FM exciter or composite STL transmitter. The adjustment is made while observing the station’s Modulation Monitor.

Regardless of the ultimate processing setup, be it a factory preset or a user-defined one, aggressive processing should always be used when setting the level of the composite/MPX output. It is under conditions of heavy processing that the Omega_FM will consistently...
maintain the maximum, ‘ceiling’ value of the limited program signal. It is this maximum level that should equate to 100% transmitter modulation.

Without a computer connected, set the Omega_Fm rear-panel FRONT PANEL LOCKOUT switch to OFF. Using the front-panel USER CONTROL buttons, set the PROCESSING for Heavy and SIGNATURE for Aggressive.

Normal maximum carrier deviation is ±75kHz, worldwide. The US and a few other regulating agencies permit a slightly higher level of total modulation when one or more FM subcarriers is transmitted.

In the US, the insertion of audio or data subcarriers entitles the broadcaster to raise total peak modulation. Adding a single, 10%-injection subcarrier would allow a total carrier deviation of 105% (±78.75kHz deviation), and if two or more 10%-injection subcarriers are added, total peak modulation can be raised to 110% (±82.5kHz deviation). Notwithstanding the FCC’s generosity, references here to “100% modulation” refer to ±75kHz carrier deviation. The user must exercise discretion and assume any risk in considering an alternative maximum deviation.

With typical program material playing, and with processing set aggressively, the rear-panel MPX LEVEL ADJUST control simply is set so that the station Modulation Monitor indicates 100% modulation on program peaks.

The Omega_Fm holds modulation peaks to a precise, ‘ceiling’ value. Once the composite/MPX output level has been set as detailed above, a less aggressive processing choice may be selected with the USER CONTROL buttons or under computer control.
Section IV
SOFTWARE MANAGEMENT

INSTALLING THE SOFTWARE

Omega_FM software can be found on the CD-ROM provided with the unit. This software runs only under the Microsoft Windows® operating system, and on PC-compatible, Pentium®-class computers. A minimum of 2MB video memory is required for reliable display of Omega_FM screen information.

**NOTE:** Install the software from the supplied CD-ROM with the computer disconnected from the Omega_FM.

**Installation Procedure**
Place the CD-ROM in the computer’s CD tray and close the tray. The software should self-start. If the computer is recalcitrant, click on Start→Run on the Taskbar, type: d:install in the Open box and click OK. The simplified installation window shown here will appear on the screen.

**Desktop Icon**
You can elect whether or not to provide a desktop shortcut (icon) and/or a Windows Start Menu entry for the Omega_FM software. These options are toggled on and off in the installation window. When these have been decided and set, click Next.

The installation utility will suggest a destination directory for the software. If your computer has typical directory tree organization, this will be: C:\Program Files\Omega_FM_2.0.0 (or the latest version), as shown. If you have a reason to specify another directory for installation, use the Browse button to choose a different destination.
STARTING THE SOFTWARE

After software has been loaded from the CD-ROM to the computer’s hard drive, now you may connect the computer to the Omega_FM.

**NOTE:** A ‘straight-through’ male/female DB-9 cable has been supplied. Use this to connect the front-panel programming port with the computer’s COM port.

Open Omega_FM software by double-clicking the desktop shortcut. The computer screen should resemble the image below.

When the computer initially communicates with the Omega_FM, the Enter Password box will appear in the top-left corner of the screen as show here. If this box does not appear, the software-default COM 1 serial port is not the proper choice, and an alternate COM port must be selected.

Choose the proper COM port by clicking on Setup→Com Setup to open the Select Com Port box. Sequentially select other ports, clicking OK after each selection, until the Enter Password box appears. The proper COM port, once selected will become the software default.
Once communications has been established, enter the factory-default password “Omega” (without the quotes but with a capital O) and click OK. The Com Status indicator in the upper right-hand corner will light, and on-screen bargraph displays will mirror the front-panel indicators. When connected, and with the Omega_FM idle, the computer screen will look similar to this:

Now you are ready to take software control of the various processing parameters. Section V and Section VI of the Manual describe the intricacies of this operation in depth.

**PASSWORD MANAGEMENT**

The Omega_FM has two levels of operator access for software control over setup and processing adjustments. The first-level password, the one asked for each time the computer connects with the Omega_FM, allows the user to change only the subjective processing parameters. These are variables that determine the station’s “sonic signature.”

**Changing the First-Level Password**

The factory-installed, default password for first-level access is “Omega” (without the quote marks, but with a capital O). This can be changed at the user’s discretion. On the menu bar, click Password→Change Password and type your choice in both spaces in the Enter New Password Twice box. The entry must consist of at least 5 alphanumeric characters and is case-sensitive. Click OK. If no error message appears, the new password has been loaded.
**Super Password**  
At this point in software installation, you also have the option of changing the second-level, supervisory password, or Super Password. This higher-level access allows highly-paid, top engineering personnel to select features and adjust parameters of a more sensitive nature.

The factory-installed, default Super Password is “Password” (without the quote marks, but with a capital P). If you change the Super Password and later forget it, Omega_FM software will have to be reinstalled to regain second-level control. To specify your own Super Password, enter your choice in each space under the Super Password (Enter Twice) heading. This must be an alphanumeric entry with 5 to 16 characters and is case-sensitive. If no entry is made, the default choice (“Password”) will be maintained.

**Retrieving Lost Passwords**  
In the midst of hectic operations around a busy station, it’s not impossible that the overworked, underpaid and flustered operator will forget the first-level password. It’s also possible that an unscrupulous PD has reassigned the password to his own nefarious ends. The first-level password can be recovered by clicking Password→View Password. You will be asked to enter the supervisory, or Super Password, to lay bare the Omega_FM’s secret.

It’s not the end of the world if the Super Password is lost as well, only that the Omega_FM computer program will have to be reinstalled from the CD-ROM. However it will not be necessary to reload any firmware (processor operating system, custom setups, etc.) from the computer to the Omega_FM. All setups and preferences that have been uploaded to Omega_FM hardware memory will be maintained.

**NOTE:** Re-installing software from the CD-ROM to the computer does replace the factory-default ‘family’ of setups on the computer hard drive. Should these later be re-uploaded to the Omega_FM as a group, user-defined Custom presets will be lost. See Managing “All” Format Files on Page 58.

**CLOSING THE PROGRAM**

**Log On / Log Off**  
Software may be left running to display Omega_FM processing action on the computer screen. To prevent accidental or unauthorized tampering with processing presets, click Password→Log Off. This will deny access to processing adjustments. Restore access by clicking Password→Log On and entering the first-level password.

It is not necessary to log off before closing the program. Simply click the boxed X in the upper, right-hand corner of the screen. Quitting the program does not alter processing; nor does simply unplugging the serial communications cable.

**Remember:** that any remote, modem control of the Omega_FM takes immediate priority over local, computer control. To avoid
interruption of local setup operations at a remote site, temporarily unplug the modem from the telephone line jack.

FIRMWARE

Firmware consists of:

- Dynamic processing routines that become resident in the Omega_FM hardware. This is the BAP.exe file.
- Factory-programmed or user-defined processing presets. These are *.fmt (format) files.

Firmware Installation

The Omega_FM comes from the factory with the most recent firmware installed just prior to shipping. These same files are nonetheless duplicated on the supplied CD-ROM so that the user can replace them if somehow the original installation becomes corrupted, or if a newer version of the firmware is issued by Inovonics. The current version of software and firmware can be checked by clicking Help→About.

**NOTE:** Do not reinstall firmware unless you are absolutely sure that it is necessary. Contact the factory if you have doubts. A complete firmware reinstallation will overwrite existing processing setup (*.fmt) files with the factory-installed presets. Any user-defined Custom presets will be lost. However, Custom presets, having become resident in Omega_FM hardware RAM, may be saved by first downloading them to a file in the C:\Program Files\Omega_FM directory. A built-in utility for doing this is detailed in Section VI, under the heading: Saving Custom Presets and Managing Files (Page 56).

Install or reinstall firmware by first clicking Setup→Install. Enter the Super Password and click OK. From this point you will be prompted to click the Continue button. Note the warnings that, during this process, the Omega_FM will be rebooted, and that the audio program will be interrupted.
Section V

CONTROLLING THE PROCESSOR

Computer control of the Omega_FM assumes a computer connected and software running. Refer to the foregoing Section IV for instructions on getting to this point.

The explanations and discussions in this Section represent a sort of “guided tour” through the Omega_FM menus and programmable features. This is more of a ‘roadmap,’ or a description of ‘how to get there’ than it is a detailed instruction of ‘what you do once you’ve arrived.’ Facts and hints on processing-in-general, including the means of developing a unique, yet listenable, sonic signature, are included in Section VI.

SETUP

Clicking Setup on the Menu Bar will display the 9-item menu shown at right. Before communications is established with the Omega_FM, only the first three items will be available, others will be ‘grayed-out.’ Once the user has logged-on, all nine items will be accessible.

Com Setup is the only menu item that can be opened without the second-level ‘Super Password.’ This protects the sensitive, more technical setup choices.

<table>
<thead>
<tr>
<th>Com Setup</th>
<th>This menu item selects the computer’s COM port. See the discussion under Communications on Page 20.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modem Setup</td>
<td>Section VII is dedicated to modem setup and operation information. This Section starts on Page 60.</td>
</tr>
<tr>
<td>Files &amp; Paths</td>
<td>The ‘firmware’ (processing program BAP.exe files) and backup copies of format presets (*.fmt files) are written to the computer’s hard drive when Omega_FM software is initially installed. The Files &amp; Paths utility shows where these files are located and allows them to be moved using the Browse function. See Saving Custom Presets and Managing Files starting on Page 56.</td>
</tr>
<tr>
<td>Install</td>
<td>The processing program and format presets resident in Omega_FM RAM are replaced during a firmware update. The Install utility uploads the necessary files from the computer hard drive to the Omega_FM. See Firmware Installation on Page 23.</td>
</tr>
</tbody>
</table>
MPX Setup

This panel contains three software controls over stereo-coder parameters.

Pilot is the percentage of contribution by the 19kHz stereo pilot of total carrier modulation. This is adjustable between zero and 20%, with the factory-default figure set at a generally accepted value around 9% (±6.75kHz carrier deviation).

The Omega_FM automatically maintains a consistent 100%-modulation output level as the pilot injection is adjusted.

Amp (amplitude) and Phase of the 38kHz subcarrier have default nominal values of ‘zero,’ representing an ideal relationship between the subcarrier (L–R difference signal), the main channel (L+R sum), and the 19kHz stereo pilot. The Amp and Phase controls may have been slightly skewed in final factory checkout to achieve best stereo separation during final test. The station engineer may further alter these adjustments to compensate for frequency response and phase errors in a composite STL or other link between the Omega_FM and the FM exciter. These settings should be changed only when a precision FM demodulator is available to verify that any readjustments actually do improve stereo separation. Make a note of any factory-set deviations from zero before readjusting, just in case.

L/R Input Setup

As explained in Section III, the default setting for software control over the Omega_FM input sensitivity is 0dB, or ‘wide open’ on the software Gain slider. This setting is essential for preserving analog input and A/D stage headroom for analog program inputs, and also represents an acceptable starting point for digital program inputs.

Refer to level-setting details on Pages 14 through 17.

Digital low-pass and high-pass filters protect the processor and stereo encoder from out-of-band program components that could cause aliasing, and from sub-audible disturbances in the input signal that can compromise modulation efficiency. Defaults for these filters are LPF On and HPF On, as shown.

L/R Output Setup

This panel gives the operator software control over the analog and digital line output levels.

NOTE: This software slider does not change the MPX OUTPUT (the composite stereo signal) level, which must be adjusted with the
associated MPX OUTPUT ADJUST potentiometer on the rear panel of the Omega_FM.

The factory-default setting of the software Level control is 0dB, or ‘wide open.’ This allows the analog program line outputs to be set at ‘professional’ levels (up to +15dBm) by the associated rear-panel OUTPUT LEVEL ADJUST potentiometers.

This default setting also makes most efficient use of the 16-bit resolution of the digital line outputs by assigning a maximum value to the peak-limited program output that is just under 0dBFS.

Output Mode defines the frequency characteristic of the analog and digital program line outputs. This does not affect the composite stereo signal (MPX OUTPUT).

The Flat Output Mode, as the name implies, creates a perfectly flat-frequency-characteristic program line output signal. Regardless of pre-emphasis selection for the composite stereo signal (MPX OUTPUT), and despite indication of independent HF LIMITING, the output is flat, and is devoid of pre-emphasis and independent HF limiting action. When the Flat mode is selected, the analog or digital line outputs can be used to feed a parallel DAB transmission channel, a satellite uplink, or a parallel AM transmission channel.

The FM Output Mode, on the other hand, does reflect the selected pre-emphasis transmission curve, and includes the independent HF ‘pre-emphasis protection’ limiting required to maintain pre-emphasized, high frequency energy at the 100%-modulation ceiling.

In the FM Output Mode, with De-Emph at 0, and with the LPF turned On, the analog and digital program line outputs will be pre-emphasized, and will reflect exactly what is fed to the stereocoder section of the Omega_FM. This output could feed an outboard stereo generator or a discrete (left/right) STL that does not contain its own pre-emphasis network.

In the FM Output Mode, with De-Emph set to the same pre-emphasis curve that is selected with the hardware jumpers (see Page 12), the analog and digital line outputs will have a flat frequency characteristic, but with a 100%-modulation value that falls with frequency. This is the same signal that would come out of an FM receiver. This output can feed an outboard stereo generator or a discrete (left/right) STL that includes its own pre-emphasis network. If this output drives the house monitor system, what will be heard around the station will precisely reflect the station’s on-air sound.
FM Output Mode with De-Emph is the factory-default setting of the Omega_FM. This option was chosen to give the processed line output the same sonic characteristic as the off-air signal.

With the LPF button On (default setting), the analog and digital line outputs reflect the low-pass action of the primary 15kHz filter. Again, the composite/MPX output is not affected by any of these controls.

**Signal Generator**

The Omega_FM includes a built-in, wide-range test tone source. This is the **Signal Generator** utility under Setup.

This test signal source may be assigned Before processing, which is equivalent to a direct connection to the digital input of the Omega_FM, or After processing, for a virtual connection directly to the input of the stereocoder circuitry.

Test-tone frequency is programmed in four ranges, and is adjusted within each range with the Freq slider.

Similarly, amplitude is programmed in four, 20dB ranges, with fine adjustment via the Amp (Amplitude) slider.

The test tone may be assigned to the L+R stereo sum, or ‘main’ channel; individually to L (Left) and R (Right) channels, independently; or to the L–R stereo difference, or ‘sub’ channel. This assignment versatility is useful in performing stereo separation and crosstalk tests.

**Remember:** to turn the Signal Generator Off when restoring normal Omega_FM operation!

**Format Converter**

This is a utility for converting processing presets generated under Version 1.1.0 software to the current Version 2. Because some processing functions have been changed and new ones added, the conversion may result in a ‘best approximation’ of creating a subjective sound as close as practicable to the original intent.

Click on Setup+Format Convert and use the Choose File button to search for earlier version format (.fmt) files. This will bring up a window where directories can be browsed to locate previous versions of format (.fmt) files.
In the example illustrated here, earlier-version format files have been stored in a directory named Old Omega. The selected first entry is the entire ‘library’ of formats used under the previous, 1.1.0 version of Omega_FM software.

The ‘36’ in the file name refers to the nine factory and three user-specified processing presets for each pre-emphasis selection: 75µs, 50µs and ‘zero.’ The utility converts all 36 presets in a single operation. If one of the other, single, ‘old’ .fmt files is chosen, it will be converted to a single, new version file.

Clicking Open brings the selected file into the file conversion utility. Clicking Convert will complete the process.

You’ll next be prompted to choose a new file name and a destination directory. In this example we have named the converted file New Format36, and have elected to place it in the current Omega_FM directory. The utility has added the .fmt extension.

Earlier format files that have been converted are managed just like current .fmt files. See: Saving Custom Presets and Managing Files beginning on Page 56.

PASSWORD

Omega_FM password protection, password maintenance and logging in and out were covered on Pages 21 and 22 in the previous Section IV.
CONTROLS

Navigating the Controls

Hovering over the Controls tab on the menu bar displays seven different drop-down menu items involved with processor setup.

Pulling the mouse pointer down past the Format selection will show that the lower six menu items each have sub-menus. To select one of these submenus, you must move the mouse pointer horizontally, sliding off the right-hand edge of the principal menu item into the submenu box.

Individual functions in the sub-menu may be clicked for access. Each will drop an adjustment ‘panel’ into the lower portion of the Omega_FM screen.

Most on-screen panels do not need to be closed individually. Subsequent panel selections are added at the right of the screen. When the screen is full, items on the left will automatically close and “drop off” the screen.

Computer Screen Resolution

Illustrations in this Manual are representative of a computer screen resolution of 800 X 600 or less. Computers with screen resolution greater than 800 X 600 will have a different aspect ratio, and will permit two rows of adjustment panels to be viewed in the ‘docking area’ below the bargraph displays.

Drop-down panels may be ‘grabbed’ by their title bars and shifted anywhere in the lower area of the screen.

The only exception with panel display ‘dropoff’ is under Parametric EQ. The parametric equalizer graph and one or more EQ adjustment panels, once selected, will remain on the screen until they are manually closed. This allows the operator to pull-up and adjust different EQ sections while watching the results on the graph. (Refer to the illustration on Page 33.)
“Format”

Clicking on Format will display a panel very similar in appearance to the USER CONTROL area on the Omega_FM front panel.

Click the up/down buttons to cycle through the pre-programmed formats, or you may simply click the indicator in the row at the left.

**NOTE:** Any time a computer is connected and communicating with the Omega_FM, when the unit is under remote control via a modem, or when processing is ‘scheduled’ for dayparting, the front-panel buttons are disabled. Software selection is then the only means of changing the processing selection.

Between the three Processing choices: Heavy, Medium and Light, and the four Signature selections: Aggressive, Smooth, Natural and Custom (user-defined), there are 12 processing presets that can be called up by the user (9 factory, 3 user). Section VI details the use of processing parameter adjustments to create the station’s ‘sound.’

Defining Custom Formats

Existing factory presets can serve as starting points for creating your own Custom processing setups. In Section VI you will learn how to modify and save user-defined presets as any of three, basic Custom selections: Custom/Light, Custom/Medium and Custom/Heavy.

Actually, an unlimited number of Custom presets may be created, though only one group of three user-defined presets can be stored in Omega_FM RAM at any one time. Others may be saved to the computer’s hard drive and uploaded to the Omega_FM, either individually or in groups of three.

“Format” Box Options

Right-clicking the background of the Format box will bring up additional utilities. Some of these utilities are purely cosmetic, such as the text font and the colors of the text, buttons, indicators, etc. Actually, nearly any portion of the Omega_FM screen can be right-clicked to customize the appearance of the window. More on this is at the end of this Section. The example Format option
screen pictured happens to show the utility for saving a user-modified “Natural Medium” processing setup as the “Custom Medium” preset. This and other aspects of File Management are detailed in Section VI.

“AGC” Clicking AGC will offer three sub-menus. Each of these can be selected, one-at-a-time, so that all three AGC panels appear on the computer screen at the same time, as shown at the top of the next page.

<table>
<thead>
<tr>
<th>AGC Time Constants</th>
<th>Gate</th>
<th>AGC Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attack</td>
<td>Release</td>
<td>Rest Rate</td>
</tr>
<tr>
<td>Slow 19</td>
<td>Fast 20</td>
<td>Slow 19</td>
</tr>
<tr>
<td>Fast 20</td>
<td>Slow 19</td>
<td>Fast 20</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**AGC Time Constants** Attack and Release are the primary rates of long-term correction for wandering levels. These control the speed at which the AGC corrects for inputs that are excessive in level, or deficient in level, respectively. The Omega FM AGC actually has a complex time constant, which is explained under Advanced AGC Controls.

Rest Rate is the speed at which AGC gain normalizes to 0dB (unity gain) whenever the program falls below the gating threshold level.

The numbers associated with these sliders are defined under the heading Processing Time Constants Explained on Page 39. The values assigned between Slow and Fast represent an optimum minimum/maximum range in each case. These numbers do not characterize a linear scale, the time constant actually doubling for each numerical increase.

**Gate** Under Gate, the Thresh dB (threshold) setting is the level below which the ‘gate’ closes and AGC gain slowly returns to its 0dB, resting value. Gating prevents a gradual increase in very low-level background sounds during pauses in the program. The threshold level is referenced to the AGC-corrected signal, and useful settings are typically in the neighborhood of –30dB.

**Advanced AGC Controls** The Max Gain slider sets the dB-amount of positive gain the AGC section of the Omega FM can impart to a below-normal program input signal. The default setting of 18 permits AGC gain to increase by as much as 18dB to bring up a weak program input signal. This figure is normal for typical AGC operation.

With some formats, classical music for example, it may not be desirable to bring pianissimo passages to full carrier modulation. In this case, the Max Gain slider might best be set at zero. This would put the AGC into a ‘safety’ mode, capable of reducing program material that was too loud, but not increasing low-level inputs. Another instance for a similar setting would be a play-by-play sportscast. During pauses in the announcing, crowd noises would be
prevented from reaching full level, yet AGC would still control the shouting of an exuberant sportscaster.

These are just a couple of examples calling for a negative-gain-function-only; that is, slowly lowering gain for program levels that are too high, but not bringing up low-level inputs beyond the 0dB resting point of the AGC. Other cases may come to mind that could suggest intermediate settings of the Max Gain slider. In most situations, however, a setting of 18, or ‘full-up,’ will yield best results.

**Secondary AGC Time Constants**

As briefly mentioned earlier, the Omega FM actually has a multiple-slope AGC correction rate. In basic terms: when the difference between the actual input level and what it should be is small, this minor amount of correction is done at the slower, primary AGC correction rate. If, on the other hand, the Omega FM determines that the level is quite a bit farther off than it should be, initial correction can be accomplished more rapidly.

The Fast Att Th (Fast Attack Threshold) and Fast Rel Th (Fast Release Threshold) controls are calibrated in dB. The indicated setting is the number of dB away from the point of present AGC gain that the faster time constant will take effect. For example, let’s assume that AGC gain is hovering at 0dB and the Fast Rel Th is set at 6. If the program level suddenly drops by 12dB, the initial 6dB of gain increase will be at a more rapid rate, slowing then to the primary AGC correction rate for the remaining 6dB of level correction. The same goes for Fast Att Th in the other direction.

The accelerated rate for initial AGC correction is set by the Fast Att (Fast Attack) and Fast Rel (Fast Release) sliders. These conform to the same time constant law as explained under the heading Processing Time Constants Explained on Page 39.

**“Parametric EQ”**

The Omega FM has four separate and completely individual sections of ‘parametric’ equalization. These may be assigned to any combination of low-frequency EQ, mid-band EQ and top-end EQ chores. However, all four sections are identical and any one may be programmed in frequency between 50Hz and 20kHz.

Clicking Graph under Parametric EQ will pop-up the panel shown on the left in the illustration at the top of the next page.

The graph displays the individual responses of the four equalizer sections, as well as a ‘composite’ of the overall effect of all four stages on the program signal.

Any one of the individual equalizer control panels can be brought up on the screen concurrently with the Graph, simply by clicking Parametric EQ, and then clicking Section 1, Section 2, Section 3 or Section 4. 800 X 600 or lower screen resolution limitations may
prevent more than the graph and one EQ adjustment panel from being shown. (See the notation on “Computer Screen Resolution” on Page 29.) Selecting an alternate equalizer panel will simply replace the existing one, though the graph will remain. The Parametric EQ Graph and any open Equalizer Section panel must be closed manually to remove them from the screen.

Within each section of parametric equalization, the Freq (frequency), Q (bandwidth) and Amp (amplitude) are individually adjustable. The pushbuttons toward the left of the EQ Section panel select the frequency range, and identical ranges are available in each equalizer section.

As each EQ slider is moved, the resultant change in response, both in that EQ section and its overall contribution, is shown on the graph. Right-clicking the graph lets you assign different colors to the graph’s background, graticule and traces.

“Multiband”

The multiband processing section of the Omega_FM is separated into two distinct and largely-independent functions: Leveling and Compression.

Drive adjusts the input level to the entire 4-band processing section. As the slider is pushed upward, there will be more indicated action in both multiband sections.

Leveling is roughly equivalent to ‘multiband AGC,’ and provides a form of “automatic consistency equalization.” The relatively slow Leveling action extends the effect of this section over a period of several seconds. Like the Omega_FM’s primary AGC, Leveling is ‘gated’ to maintain spectral uniformity during pauses or lulls in the program.

Leveling Attack, Leveling Release, Leveling Gate Threshold and Leveling Gate Rest Level are similar settings to the like-named AGC adjustments. Similar explanations and instructions apply. Section VI will detail the subjective effects of these adjustments.

The second multiband function is Compression. Compression reduces program dynamic range, and in a multiband implementation
this is done on a frequency-discriminate basis in multiple bands. Compression is a more rapid, ‘syllabic’ rate of correction than Leveling, and is most instrumental in increasing program density, one factor of perceived program loudness.

Clicking on Compression Drive brings up a panel of adjustments over the input gain to each of the four bands of compression. Similarly, Band Output is a set of four adjustments over the output level of each band. Compression Attack and Compression Release have a bearing on program density as well, and all these adjustments are used in concert for useful and flexible ‘dynamic equalization’ of the program signal. Again, refer to Section VI for using these variable controls to best sonic advantage.

**Bass Enhance**

This slider controls a psycho-acoustic low-end “harmonic-management” algorithm. It is important to understand that this is not just another stage of equalization. Rather, harmonic components of very low-bass fundamentals may be accentuated and phase-aligned to give a subjective increase in the amount of perceived bass without materially adding to the total peak modulation.

The Bass Enhance slider is calibrated in dB, equating closely with the amount of perceived low-end boost that it affords. The Bass Enhance feature is particularly effective at coaxing a ‘big sound’ out of little radios.

**“Limiter”**

Clicking on Limiter drops down a sub-menu of five adjustment panels.

As the name might imply, Wideband Limiter Drive controls the input level to the entire peak-limiting section of the Omega FM.

Peak limiter dynamics are separated by a floating gain platform. Instantaneous program peaks release at a fast rate to the platform value, and the platform then releases at a slower, secondary rate. The level of the release platform is a function of the average value of peak limiting.

Wideband Limiter Time Constants is a panel affording adjustment over limiter attack and release, both for the peak (Pk) value of the limiting function, and for the platform (Plat) value. These adjustments are perhaps the most critical factors in securing a high level of ‘perceived loud-
ness,’ consistent with a clean sound, which is devoid of ‘grunge’ and other processing artifacts that can promote ‘listener fatigue.’ Section VI discusses these adjustments.

The Omega FM includes an independent high-frequency limiter to control program energy that is redistributed and exaggerated by the transmission pre-emphasis characteristic. This separate HF limiter follows the wideband limiter. Click on Limiter Balance to bring up the HF control panel.

When the slider is pushed fully ‘up’ to the WB end, the threshold of the wideband limiter is set precisely to the 100%-modulation point. Since this leaves no headroom for the pre-emphasized program component, the independent high-frequency limiter has to work very hard to keep high frequencies under control. By lowering the wideband limiter threshold; that is, pulling it down toward HF, progressively more headroom is provided for pre-emphasized program material.

A “happy medium,” 50/50 setting of the HF slider would share limiting duties evenly between the wideband and high frequency limiters. A higher WB setting will result in a slight loudness increase at the possible expense of a ‘muddy’ top end. A higher HF setting yields a brighter, more transparent sound at the sacrifice of ultimate loudness. More on this subject will be found in Section VI.

The high frequency limiter has independent HF Limiter Time Constants. Opening this sub-menu panel affords control over HF limiting attack and release times. As this limiting section works at a more rapid an unobtrusive rate than the wideband limiter, a ‘platform release’ function is neither required nor included.

Clicking on Pre Emphasis displays a panel that shows a scale continuously adjustable between zero and 75 microseconds. Note, however, that the panel title bar is ‘grayed out’ and that the slider is inoperative. The hardware jumper installed for 50µs or 75µs pre-emphasis (described on Pages 12 and 13) renders this slider inoperative in conventional FM processing service. This slider functions only when the jumper is in the ‘zero’ position, otherwise it serves solely as an indicator of the jumper setting.

“MPX” Clicking MPX presents two sub-menu selections: Clipping and Clipping Mode. Clicking on each of these, in turn, brings both associated adjustment panels into view, as shown.

The MPX slider adjusts the depth of composite, multiplex signal clipping in dB. This hard-clipping action takes place prior to the insertion of the 19kHz stereo pilot.

The Clip panel allows the user to select either a Raw clipped composite output or a Filtered output.
Used judiciously, composite clipping can materially increase the perceived loudness of the broadcast signal. Any clipping will generate spurious products outside the frequency spectrum of the composite, stereo-multiplex signal, and without subsequent filtering these clipping by-products could interfere with the stereo pilot or jeopardize performance of RDS and other data or analog subcarriers.

The Omega_FM incorporates a unique output filtering algorithm that protects both the 19kHz stereo pilot and the spectrum above the 53kHz top edge of the multiplex signal. The option of whether or not to filter is left to the user’s discretion. With some types of program material, and depending on other processing parameters selected, there may be a slight loudness advantage using the Raw output. The output spectrum of the Omega_FM will be cleaner with the Filtered selection.

“Other” Other is a path to the processing Bypass panel. A ‘virtual pushbutton’ switch enables the operator to turn Proc (processing) On and Off. In the Off position, the input program is delivered to the program line outputs with no gain change. The stereocoder remains active, but the program level will necessarily be at a very low level to avoid carrier over-deviation, and there will be no pre-emphasis.

REMOTE CONTROL

Section VII of this Manual contains instructions for connecting and using an external modem for full remote control of the Omega_FM.

‘DAYPARTING’

Effective with release of Rev. 2 software, the Omega_FM includes a built-in scheduler for ‘dayparting’ (changing processing parameters in accordance with a fixed time schedule).

Click Daypart to bring this panel onto the computer screen.

An important aspect of scheduling is the accuracy of the clock that calls up processing changes. Changes may be scheduled ‘on the hour,’ though other switchover times might be called for.
Synchronizing the Clocks

Clicking on Time Check opens this box, which shows two current times. Omega Time is that of the Omega_FM’s internal clock, Time Here is the time on the internal clock of the connected computer.

The Omega_FM internal clock is accurate to about 10 seconds in one month. Note that in the example shown, Omega Time lags Time Here by about 30 seconds. This utility updates the Omega_FM internal clock to that of the computer. This of course means that the computer clock must be assured of its accuracy before the Omega_FM clock is updated. With a precise time reference at hand, the computer clock is set using the Date/Time utility under the Windows Control Panel. Once this has been done and confirmed, simply click Synchronize to reset the Omega_FM to the same local time.

To assure the accuracy of automatic processor scheduling, clock synchronization should be checked regularly.

Creating and Editing Daypart Entries

A processing schedule is created in the Daypart <Omega> window using the Entry utilities for adding and deleting items and for editing entries. A daypart schedule uploaded to the Omega_FM is a weekly schedule, and will simply repeat week-after-week, so long as the function is kept active. However, any number of schedule files may be created and saved on the computer hard drive. These may be uploaded to the Omega_FM as propriety demands, to accommodate seasonal or other changes in the station’s programming. Schedule data is maintained in a .shd (schedule) file in the main Omega_FM program folder.

Click Entry→Add to bring up the Add Daypart Entry window. This utility allows selection of the Day of the week, the Hour and the Minute for a segment starting time, plus the 12 possible Format selections. When a segment starting time and processing selection has been entered, click Add to add it to the schedule.

Any number of segment starting times can be added before closing the Add Daypart Entry screen. What’s more, segments may be programmed in any order and they will automatically arrange themselves chronologically. This makes it easy to repeat a common starting time for each day in the week, for instance.
In this example, we have set a weekly schedule for a rock station. The format remains constant Monday through Friday. Processing is set to Aggressive Heavy between 6AM and 10PM, and to Aggressive Light through the night.

On Saturday, the schedule changes to accommodate daytime sports and local affairs programming. A Custom Medium setup is called-up from 6AM to 8PM, changing to Aggressive Light for rock music through the night.

Sunday, lightly processed religious and local affairs programs occupy the early morning time slots. The format reverts to heavy rock at noon, with lighter processing called-up for the night hours.

Once the Edit Daypart Entry box has been closed, clicking on any single entry in the scheduling panel will highlight that entry. The highlighted entry may be deleted with the Entry→Delete key, or modified with the Entry→Edit key.

The Edit Daypart Entry box is identical to the Add Daypart Entry box, except that it is used only to change a highlighted dayparting segment.

**Daypart On/Off**

Note the Daypart On and Off buttons at the top of the Daypart <Omega> screen. This attribute stays with the file when it is saved or uploaded to the Omega_FM. It’s probably wise to save all .shd files with Daypart set to On. This will prevent an ‘Off’ schedule from being uploaded to the Omega_FM, which then would just sit there and do nothing.

**Saving Schedules**

After a schedule has been created, click on File→Save to put this schedule on the computer’s hard drive. You will be asked to give the file a name. This can be anything to distinguish the new schedule from one already created, or from one you might later wish to create.

**Fetching and Sending Schedules**

Clicking on Omega→Fetch will download any current dayparting schedule resident in the Omega_FM to the computer screen. This operation does not remove the schedule from the processor, however.

Any schedule that has been saved to the computer hard drive may be called into the Daypart <Omega> window with a File→Open.
command. The file name will appear at the top of the window. Clicking Omega→Send will upload that schedule to the Omega_FM.

Don’t forget: to click the On button before sending (uploading) a schedule to the Omega_FM. If you wish to suspend dayparting, use the Omega→Fetch command to bring the current schedule onto the computer screen, click Daypart→Off, then use Omega→Send to upload the turned-off schedule back to the Omega_FM. The opposite routine may be used to reactivate dayparting.

Priorities

When activated, dayparting overrides the Omega_FM front-panel USER CONTROL buttons, regardless of the position of the FRONT PANEL LOCKOUT switch on the rear panel of the Omega_FM.

A format change initiated by a connected computer or modem link will override dayparting so long as the connection is maintained. Upon disconnection or log-off, dayparting schedules resume automatically.

PROCESSING TIME CONSTANTS EXPLAINED

The seemingly arbitrary numbers assigned to attack, release and other processing time constants actually are mathematically related to the Omega_FM’s 48kHz sampling frequency. The equation is: 
\[ t = \frac{2^n}{48000}, \]
where \( t \) is time in seconds, and \( n \) is the number displayed on the attack and release adjustments. The table below covers the range of numbers used.

<table>
<thead>
<tr>
<th>Omega Number</th>
<th>Time Constant</th>
<th>Omega Number</th>
<th>Time Constant</th>
<th>Omega Number</th>
<th>Time Constant</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>0.7ms</td>
<td>12</td>
<td>85ms</td>
<td>19</td>
<td>11sec</td>
</tr>
<tr>
<td>6</td>
<td>1.3ms</td>
<td>13</td>
<td>171ms</td>
<td>20</td>
<td>22sec</td>
</tr>
<tr>
<td>7</td>
<td>2.6ms</td>
<td>14</td>
<td>341ms</td>
<td>21</td>
<td>44sec</td>
</tr>
<tr>
<td>8</td>
<td>5.3ms</td>
<td>15</td>
<td>683ms</td>
<td>22</td>
<td>87sec</td>
</tr>
<tr>
<td>9</td>
<td>11ms</td>
<td>16</td>
<td>1.4sec</td>
<td>23</td>
<td>175sec</td>
</tr>
<tr>
<td>10</td>
<td>21ms</td>
<td>17</td>
<td>2.7sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>43ms</td>
<td>18</td>
<td>5.5sec</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The full range of time constants shown above has not been made available on any single Omega_FM slider. Rather, each slider has been given a range consistent with the control appropriate to the particular function.

OMEGA_FM CONTROL SCREEN OPTIONS

Many of the items that appear on the Omega_FM control screen can be customized by right-clicking with the mouse.

Appearance

Colors and fonts are among the appearance items that can be customized. Style 1 and Style 2 are factory appearance settings. The Windows color palette gives an almost unlimited range of color combinations beyond these two primary choices. The two factory
styles are somewhat ‘global’ in their effect, and can modify several attributes at once, depending on what area of the screen has been right-clicked. Keep in mind that choosing one of the default styles will immediately undo individualized, custom appearance choices.

Right-clicking on separate items (buttons, indicators, readout bars, etc.) may let you change these individually, or your choice may be reflected in all similar items. For instance, changing the background color for adjustment sliders affects all sliders, yet separate colors may be assigned to groups of readout bargraphs. Please feel free to experiment with appearance items to create a customized screen you’ll be proud to show your friends and family.

**Input Metering**

Right-click on the Input meter to show display options. In addition to appearance choices, three operational preferences also are available.

**Meter Range Select→Normal** extends from –20dB to +10dB. This gives a total metering range of 30dB, which corresponds to the fixed range of the Omega FM front-panel bargraph **INPUT** meter. By clicking **Meter Range Select→Extended**, the range of the on-screen meter, only, can be expanded to 80dB, or from –70dB to +10dB.

The Input meter is absolute-peak-responding. However, the **Decay Rate** may be programmed for a Slow, a Medium or a Fast ‘visual fallback,’ and the **Peak Hold Time** is programmable for a Long, a Medium or a Short persistence of the held peak ‘dot.’ These selections change the visual display only, and do not affect the response of the meter to program peaks. Measurements will be consistent with any selection.

**Leveling, Compression and Limiting Meters**

The **Decay Rate** and **Peak Hold Time** of the four Compression meters may be programmed in a similar manner. These meters are peak-responding, and accordingly react to the compressor’s programmed attack time. Any change to their fallback or persistence characteristics is exclusively a matter of visual aesthetics. Accuracy of readings will not be compromised.
Output Metering

Right-click on the Output meter to show metering options. Aside from the usual cosmetic preferences, the Output meter may be assigned different monitoring functions, as well as scaling and meter fallback choices.

In normal FM broadcasting service, the usual function of the output meter is the display of percent-modulation of the composite/multiplex output signal. This is an important indication as it correlates directly with actual FM carrier deviation. This meter also illustrates the effectiveness of overall audio processing, showing the compression of program dynamic range and the maintenance of peak levels at the 100%-modulation value.

The Clip indicator at the top of the Output meter (in the Coder mode) lights whenever the composite-multiplex signal reaches the output clipping level. This is not an indication of how heavily the Omega FM is into clipping. Clipping depth is entirely dependent on how the Controls→MPX→Clipping adjustment has been set.

Alternatively, the Output meter may be assigned to monitor the Left and Right channel Line Output levels. Click on Output Meter Select→Left/Right to switch to this metering mode. Once Left/Right metering is displayed, right-click on the meter again to show further options.

Either a 40dB or an 80dB stereo Line Output metering range is available. 0dB on the Output / L R meters represents digital full-scale, or 0dBFS of the digital Line Output signal. As the analog Line Output is adjusted with rear-panel potentiometers, 0dB represents the level prior to digital-to-analog conversion.

The Output meter is absolute-peak-responding. However, the Decay Rate may be programmed for a Slow, a Medium or a Fast ‘visual fallback,’ and the Peak Hold Time may be programmed for a Long, a Medium or a Short persistence of the peak-held display. These selections change the visual display only, and in no way affect the response of the meter to program peaks.
Section VI
CUSTOMIZING PROCESSOR SETTINGS

This Section of the Manual goes into detail regarding the more subtle adjustments to the Omega_FM, and the procedures required in creating a desired “sonic signature” for the station.

Be aware that these procedures are presented redundantly; that is, initial steps for ‘roughing-in’ and follow-up ‘fine-tweaking’ notes.

**NOTE:** We suggest you read through this section in its entirety before making any adjustments.

**GENERAL**

**Setup**
At this point you should have followed procedures in Section IV of this Manual to install the control software for the Omega_FM onto a PC, and then to establish serial communications between the PC and the Omega_FM. Once the PC is displaying the ‘Omega Screen,’ you should be able to select between the various factory-installed formats under PC control (see Page 29).

**REMEMBER:** The Omega_FM front-panel selector buttons are disabled when the unit is under PC control, or when the built-in scheduler is activated for dayparting. When under remote, modem control, both the front-panel buttons and local computer control are disabled.

Some familiarization and preliminary work can be done ‘on the bench,’ listening through the Omega_FM program line outputs. But final tweaking should be carried out through a real air chain (the Omega_FM connected to a suitable exciter or transmitter) to ensure proper setup of processing adjustments. This can be the station’s primary transmitter for actual on-air setup, or a spare exciter tuned to another frequency. The latter choice serves as a ‘parallel air chain’ and permits A/B comparison with the station’s existing air sound. Be sure the Omega_FM input gain is set properly (see Pages 14 through 17), and that the output level is adjusted to drive the transmitter or exciter to full carrier deviation (see Pages 17 and 18).

**Program Source**
The program source for any processor setup should always be the station console feed. Depending on the professionalism of different operators, the output level from a working radio studio varies considerably more than that from a CD player or other ‘test’ program source one might be tempted to use for setup.
The monitoring equipment used to evaluate changes to the processing is of critical importance and should be representative of what typical listeners will be using. Take a sampling of what environments your listeners are apt to be in and use a representative range of receivers. What comes out of your JBL monitors will bear no resemblance to what a driver hears from the Delco radio in his Buick. Though high quality monitoring certainly has a place, fine-tuning processing for the best sound from your big, wall-mounted studio monitors is risky.

It is generally a good idea to obtain a clean feed of the studio output and have this available for comparison with the processed signal. A level control on this feed, and a quick means of switching to it, are invaluable for evaluating what the processing is really doing to the music on your station.

The art of good audio processing is all about achieving the right balance between different, and often-competing goals. Take a moment to think about the goals appropriate to your station and to your market.

For example, some of the most usual goals are to achieve a competitive level of perceived loudness, to retain some degree of fidelity to the original recording, to avoid distortion (particularly important on voices), and to create a ‘signature sound.’ Consider carefully who should have an input into setting up the audio processing and discuss these goals with them. Try to characterize your ideal sound. It may be helpful to write down the outcome of these deliberations.

The traditional functions of broadcast audio processing systems have been threefold:

1) To maintain carrier modulation limits within established legal parameters. This is the function of peak limiting.

2) To maximize broadcast carrier modulation density, historically in an effort to overcome reception problems in fringe areas, thus extending the station’s coverage. This function is achieved through dynamic range compression.

3) To create a signature sound for the station, a sound that reflects or intensifies the theme of the station’s format, or a sound that appeals to the taste of the targeted audience. This function is accomplished through equalization, signal processing in multiple frequency bands, and any of a number of “effects” processing techniques (eg: spatial enhancers and ‘aural exciters’).

Contemporary processor designs address the broadcasters’ desire to be LOUD. “Loudness wars” began in AM radio in the 1960s. The ‘louder is better’ school of thought continues to have a strong following, even in FM, though format and good programming are invariably the keys to success at any station.
Today, with several stations in any one market providing nearly identical programming, long-term listsenableity emerges as a real and critical factor in audience satisfaction and higher ‘quarter-hours.’

‘SOFTWARE SLIDER’ BASICS

The Omega_FM software interface has been designed so that advancing a slider upward causes the amount of boost or dynamic processing to increase. So if you want more of something, push the slider up. If you want less, pull it down.

Attack times get longer as the relevant slider is pushed up; release times get shorter. This will equate to greater loudness or density in both cases. The numbers in the time constant sliders are a logarithmic scale based on powers of 2 and the sampling rate. If you care to know the actual time constant in milliseconds or seconds, see the discussion and table on Page 39. Setup notes and hints having to do with time constant adjustments are at the end of this Section.

HOW TO START

We energetically recommend that you first listen carefully to all the factory-programmed processing presets and select one that gets you closest to your ideal. This gives you a starting point based on the work of our team of crack audio processing professionals and their consulting gurus, who have worked with a wide variety of program material (music, voices and ‘produced’ items like commercials) to establish the factory presets.

Under PC control you can then carefully nurse-in the format to give exactly the sound you desire. Then your proprietary setup can be saved in one of the three Custom memory positions designed for that purpose.

NOTE: Once again, we emphatically urge you read through this Section (Section VI) in its entirety before making any adjustments.

WHAT TO ADJUST FIRST – ‘ROUGHING-IN’

In general, do not adjust any time constants (attack and release times) until you are very familiar with the Omega_FM, and only after you have experimented with all the Drive, Gain and EQ controls. Setting the time constants requires a lot of knowledge and can have unexpected effects on different types of program material. In-depth information on setting the time constants is presented later in this Section.
**AGC Level**
The setup of Omega FM Input Gain is detailed in Section II, on Pages 14 through 17. When input gain is set properly, the AGC should, most of the time, hover within a couple of display divisions of 0dB. If this is not the situation, use the cited setup instructions to normalize AGC gain.

**Parametric EQ**
Begin by tailoring the four Parametric EQ sections in the direction of the 'signature' you desire. Parametric EQ adjustments were introduced on Page 32, and additional setup hints are found on Page 47.

There are other adjustments and ‘tricks’ that can be used to generate heavy bass, vocal ‘presence’ or a crisp top end, so don’t despair if you can’t achieve your goal the first time around.

A good rule of thumb is to aim to get about a half to two-thirds of required EQ ‘signature’ from the Parametric EQ, and the rest from offsetting the individual Multiband→Compression Drive controls and the Multiband→Band Output controls.

**Leveling**
The various Multiband controls are explained on Page 30. First, work on Multiband→Drive to achieve the right amount of consistency from the 4-band leveling stage. As the leveling function is essentially a ‘multiband AGC,’ full sonic consistency is assured when all bands are active. The Drive control should be set so that at least three of the four Leveling indicators show gain reduction when representative music is being played.

**Compression**
Adjust the individual Multiband→Compression Drive and Multiband→Band Output controls to home-in on your sonic signature. Increasing the Compression Drive controls will make for a ‘denser’ and ‘busier,’ but perhaps ‘mushier’ sound in the band being worked on. Increasing the Band Output control will increase the contribution of that band in the final mix, causing it to be louder, but the sound will be more heavily processed by the following limiter and composite clipper stages, which may result in that band suffering more from limiter and/or clipping artifacts. Different artifacts will be more noticeable on some tracks than on others, so it is not a bad idea to try and trade off the above artifacts equally, averaged over several tracks.

**Bass Enhance**
Theory behind this control is explained on Page 34. The effects of this processing algorithm will vary, depending in large part on the monitoring system used for listening. Evaluate the effects of this control on both large and small monitor systems.

**Limiting**
The Limiter→Wideband Limiter Drive and the MPX→Clipping (Composite Processing) adjustments are the final links in the dynamics processing chain. These two controls will exert the greatest influence over the inevitable tradeoff between loudness and quality of the transmitted signal. Feel free to experiment with these controls during this initial setup phase; additional notes will follow.
PLEASE: At this point STOP and, unless something is dramatically amiss, take a break. The ears soon get tired, and a rest will help you hear better and hear more in the long run.

ALSO: Evaluate the sound over a period of time... at least half an hour, preferably over a day or two. If you can do it, resist the temptation to dive straight back in and tweak something. Use a notepad, your Palm Pilot®, or the Processor Setup Worksheets included in the Appendix of this Manual to take notes of good settings or of problem areas for subsequent cleanup.

FINE-TUNING OMEGA_FM PROCESSING ADJUSTMENTS

The remainder of this Section is devoted to helping you secure exactly the ‘signature sound’ you want for your station. Starting with the closest factory-preset, or a preliminary Custom processing setup that you have modified, the following hints and explanations will help you fine-tweak the Omega_FM into giving the very best sound obtainable anywhere.

AGC

AGC Maximum Gain
For applications demanding little or no AGC action (classical music, for example), set AGC→Advanced→Max Gain to 0dB. With this setting, AGC gain is permitted to go only in the negative direction, the AGC acting only if the operator allows the level to get abnormally high.

AGC Time Constants
AGC→Time Constants and AGC→Advanced→Fast Att and Fast Rel should all be set at their highest numbers for very slow and unobtrusive operation; AGC→Advanced→Fast Att Th and Fast Rel Th are probably best set to the highest dB settings for classical music also. Rock music, talk programming and most other applications that demand active AGC action will probably best be served with the default, factory settings. When modifying factory AGC settings for Custom processor setups, be sure to listen to the effect of any changes under a wide variety of programming.

AGC Gating
The AGC ‘Gate’ prevents excessive buildup of low-level passages, background noises and reverberation when the level of the incoming signal is below the gating threshold.

When the incoming signal is very quiet, and thus below the gate threshold, AGC gain heads towards 0dB at a rate determined by the Rest Rate control under AGC Time Constants. If the AGC were not gated, the ‘hunting’ (gain-stabilizing) action of this stage would progressively boost these very quiet passages.

The Gate Thresh (Threshold) control can be set by ear to give the desired effect on program material. Do ensure that the incoming input level is correct when setting up this function. Reducing Gate Thresh towards –40dB will allow quieter sounds to be gradually...
brought up by the AGC. Alternatively, increasing the Gate Thresh towards 0dB will restrict AGC action to relatively louder sounds. Somewhere in the –30dB region should be optimum for most cases.

EQUALIZATION

Please refer to Page 32 for details regarding the management of the Parametric EQ screen.

The Omega_FM provides four, fully-variable parametric (or ‘peaking’) equalizers. These EQ sections are effectively positioned immediately after the AGC and ahead of the Multiband Leveler.

Remember that parametric equalizers can be used to cut as well as to boost a range of frequencies.

Center Frequency

The Freq (center frequency) of each parametric EQ section can be set anywhere within the 50Hz to 20kHz range. This makes it possible (though not recommended!) to tune two or three sections close in frequency to obtain more than 10dB of overall boost. The associated Graph will display the resulting curves in real time as the sections are adjusted. This makes it easy to set up the EQ for a desired overall curve. An automatic normalizing process ensures that there is no possibility of overloading subsequent stages with any EQ setting, but we recommend not exceeding 10dB of boost or cut at any frequency, as this would be almost certain to sound very strange.

Remember to make allowances for different types of consumer receivers, particularly when adjusting for ‘thunderous bass.’ The speakers in small radios are generally ineffective below about 90Hz, so large amounts of bass boost below this point may well cause small radios to distort quite badly.

‘Q’ and Amplitude

The Q slider affects the width of the peak (or notch) created by the equalizer, the Amp slider assigns the amount of boost (or cut) at the chosen frequency. 1.5 is a good ‘Q’ value in beginning any experimentation. Narrower peaks may not be audible on some types of program, whereas wider peaks may affect too broad a range of frequencies to be of much use. When starting to experiment it may be helpful to set the Amp slider temporarily at maximum boost (+10dB) and sweep the Freq and Q sliders up and down to acquaint the ear with the frequency range being processed. Once you have optimized the center frequency and ‘Q’ for the desired range of frequencies, then reset the Amp slider to a more reasonable figure.

MULTIBAND LEVELER

Drive

When adjusting the Multiband→Drive slider, keep an eye on all eight gain reduction meters associated with the multiband section of the Omega_FM.
Multiband→Drive affects the amount of gain reduction in both the Leveler and Compressor sections of the Omega_FM. Once the Leveling indicator shows at least 2dB to 3dB of gain reduction in a particular band, a further increase in M/B Drive will simply increase leveling gain reduction and will not have an effect on the corresponding band of compression. The exact relationship between these two functions will depend on the source material and the selected time constants... it gets complicated!

Increasing gain reduction in the leveling section will give the Omega_FM more power to ‘dynamically re-equalize’ different sources and tracks; that is, it will impart more spectral consistency to the program. Although the amount of gain reduction in the leveler is normally less than that in the compressor, the overall effect of leveling on perceived frequency response is much more noticeable due to the extended time over which the leveler acts.

3dB to 4dB of ‘standing’ (long-term average) gain reduction in the leveler equates to 6dB to 8dB of total, dynamic control range. Normally this amount is sufficient to ‘sweeten’ old or poorly produced cuts, but not so much as to create unnatural, potentially annoying and exaggerated skewing of the frequency response.

There are some proprietary techniques built into the multiband section of the Omega_FM that help lessen these response-skewing effects. If you see the gain reduction meters behave in an unexpected manner, this will probably be the reason.

**Leveling Gate**

Gating in the leveling section prevents excessive buildup of noise and/or reverberation during quiet passages. The leveler’s gate forces gain reduction to a resting level when the wideband input signal to the entire leveling section falls below a programmed threshold value.

The action of the gate will be similar to a ‘freeze gate.’ In fact, the release time is not frozen, but is switched to a much slower rate of return to the resting point.

The gating threshold slider, labeled M/B Gate, is accessed via Multiband→Leveling Gate Threshold. Unlike the AGC gating function, which distinguishes between legitimate program and background noise, M/B Gate responds to the more ‘active’ program material. Settings in the range of –10dB to –15dB are typical for pop music, –15dB to –20dB for jazz and classical programming.

**Rest Level**

The leveler’s resting level should be set to a value close to the typical gain reduction shown on the Leveling meters once the M/B Drive slider has been set. Access the M/B Rest Level slider by clicking on Multiband→Leveling Gate Rest Level.

M/B Rest Level can also be set to a value higher than the typical indicated gain reduction. In this case the gate can act as an expander, where the expansion time constant is somewhat slower than the main release time in each band.

If in doubt, leave M/B Gate set at the factory-preset value unless you significantly reduce the multiband drive (by more than about 3dB).
In this case, just reduce the M/B Gate (toward –20dB) and increase the M/B Rest Level (toward 0dB) by the same amount that you reduced the multiband drive.

**COMPRESSOR**

**Compression Drive**

For classical music and jazz, normally 3dB to 6dB indicated gain reduction in the most active Compression meter band is the most compression that should be used.

For good consistency in most other formats, use at least 3dB of indicated Compression on the least active meter. An exception to this rule would be in the Compression / LM (Low Mid) band. With only 1dB or 2dB of gain reduction showing here the result can still sound just fine.

An average of 6dB compression is good for general applications. Increasing Compression Drive can make the program sound ‘packed,’ or lacking in detail. Keep an eye on the Compression meters when making adjustments. About 10 dB in the most active band is the recommended maximum compressor-stage gain reduction for most formats. This will depend on the program and the degree of Leveling gain reduction. Occasional Compression peaks above 10dB are acceptable as the leveler accommodates a louder passage.

**Band Outputs**

The four Band Output sliders have greater ‘leverage’ than the four Compression Drive (input) controls, hence the restricted control range of ±3dB. To avoid possibly the worst type of intermodulation distortion; that is, the high frequencies modulated by individual cycles of very low bass, keep Low and High Band Outputs below the mid bands.

The four bands have a proprietary normalizing system for the band thresholds. If you change from full cut on all bands to full boost on all bands, don’t expect to see a 6dB increase in activity in the following wideband limiter stage.

**Bass Enhance**

Once again we recommend that you to listen to the effects of Omega_Fm processing on a variety of representative radios and monitor speakers. The effect of the Bass Enhance control is perhaps more noticeable on smaller monitors than on large ones.

**LIMITER**

As stated earlier, wideband limiting and composite clipping will have the greatest influence over the tradeoff between loudness and audio quality. The algorithms used in the final dynamics processing stages of the Omega_Fm are the result of several years’ research and code preparation.
The Omega_Fm does not employ any conventional clippers, except at the final composite clipper stage, where this is absolutely necessary for final, very tight peak control and to establish the 100%-modulation ceiling. There are, however, embedded clippers of a proprietary type in all stages for controlling only the very fast overshoots. Proprietary techniques, including look-ahead peak control, eliminate what has become known as “digital grunge,” a particular form of clipping distortion endemic not only to digital, but also to all analog processing systems that employ conventional clippers. There is no ‘Main Clipper’ or ‘Left/Right Clipper’ control in the Omega_Fm.

Wideband Limiter Drive

Adjust the Limiter→Wideband Limiter Drive control for the desired amount of loudness, consistent with good sound quality, as judged by critical listening. Monitor on a range of different receivers to assess any degree of quality degradation, making sure artifacts remain within acceptable limits. Keep an eye on the Limiting / W (Wideband Limiter) gain reduction meter. We recommend a peak gain reduction of no more than 6dB on regular ‘beats,’ with occasional, very brief peaks up to 7dB or 8dB. As you increase Wideband Limiter Drive, particularly above the recommended figures, listen for hints of ‘pumping,’ along with intermodulation ‘muddiness’ and distortion-in-general. Tracks that have been poorly produced suffer the most under excessive wideband limiting, so avoid setting this control while listening only to the “top-40,” unless this is the only material that your station ever plays.

Limiter Balance

The HF Limit Bal control is accessed via Limiter→Limiter Balance. This single control varies the thresholds of both the wideband and the independent high-frequency limiter sections. (See Page 35.)

Taking the slider from the center position (50%) toward 100% WB makes the sound slightly louder, though at the expense of it being ‘duller’ and ‘mushier’ due to greater HF limiter action.

As the slider is moved toward HF, the wideband limiter threshold is reduced and the high-frequency limiter does not have to work as hard. The result is a much cleaner, brighter sound for a small penalty in loudness.

We have found that a setting of 85% WB works well in most situations.

OUTPUT

Composite processing is carried out entirely in the digital domain, and the signal has been heavily oversampled to avoid aliasing distortion. Adjustment of the MPX→Clipping→Clip control is similar to that of the final limiter, above, except that the artifact you are listening for is clipping distortion. Clipping distortion sounds like ‘tearing’, ‘screeching’ or ‘spitting,’ accompanied by excessive perceived brightness or ‘sizzle.’ 0dB to 1.5dB of Clip is the intended working range and will satisfy nearly every application; 0dB mainly
for classical music and jazz, 0.5dB to 1.0 dB for Smooth / AOR formats, and 1.5dB for CHR, Urban, Dance and Rock.

Be sure to abide by local regulations concerning composite clipping, and be aware that the noise-floor in the baseband subcarrier spectrum between 53kHz and 100kHz will be raised by the action of the composite clipper. Choosing MPX-Clipping Mode-Filtered will afford greatest protection of the composite/MPX output spectrum, though at a very slight loudness tradeoff. Digital subcarriers are unlikely to be affected, but if you run analog subcarriers, the crosstalk should be checked when adjusting the Clip slider.

**PROCESSING TIME CONSTANTS**

**WARNING:** Inovonics’ Omega_FM is the only digital broadcast processing system that permits a wide latitude of user control over every one of the processing time constants. Although the range of control has been restricted to values that have been engineered to ‘keep you out of trouble,’ the effects of time-constant programming can be additive, or cumulative. It is entirely possible to create an ‘unusual,’ if not a downright ‘nasty’ sound by violating certain setup rules.

**PLEASE** read this portion of Section VI carefully before deviating from the factory-preset values for time constants. As mentioned, the range of control is restricted, and has been skewed (centered) optimally for each one of the various adjustments. In all likelihood the final settings will fall in the central half of the range in each case. If this is not the way it turns out, or if in doubt, do defer to the factory-preset values.

**AGC Time Constants**

Omega_FM’s detection of levels for the AGC stage is always based on peak level, integrated at 10ms (like a PPM meter) to remove very short transients. Correction rates are entirely separate from the detection time constants and are detailed below. This makes AGC action rather like a trained operator making thoughtful level corrections while watching a PPM meter.

**AGC Attack** utilizes exponential time constants, where the rate of gain-change depends on the amount of change required. Attack time is the time for the AGC to reach approximately 75% of its final gain reduction following a step increase in the input level. The attack function will progressively slow as it reaches its target.

**AGC Release** is a linear time constant, where the rate of change of gain is a constant dB-per-second correction. Release time is the time taken for the AGC to reach approximately 75% of its final gain increase following a step decrease in the input level. The release function acts at a constant rate.

**Rest Rate** is an linear function, like Release (above), and is the time it takes for the AGC to get about three-quarters of the way back to 0dB after the input level falls below the gating threshold.
The secondary time constants accessed under Controls→AGC→Advanced regulate the initial rate of AGC correction defined by the associated Fast Att (Attack) and Rel (Release) Th (Thresholds). The actions of the secondary time constants were explained on Page 32.

As mentioned earlier, the numbers on the time constant sliders are a logarithmic scale based on powers of 2 and the Omega_FM sampling rate. The table on Page 39 gives actual numbers for timing.

AGC time constants can be adjusted by ear according to preference. A proprietary algorithm protects the AGC from overload if a very slow attack time is selected. If unsure, keep the attack one step faster (one number lower) than the release. It is not a good idea to set the attack slower (a higher number) than the release.

AGC time constants between 18 and 20 have been found to work well with most types of program material.

**Multiband Time Constants**

Linear time constants are utilized throughout the Multiband section. The rate-of-change is a constant dB-per-second correction. The time constant is defined as the time it takes a stage to reach approximately 50% of its ultimate gain control following a step change in the input level. Although based on peak detection, there is no decoupling of the detection rate and the correction rate as was described for the AGC stage. Therefore, the response of the Leveler and the Compressor sections can be anything between quasi-peak-responding (fast attack) and r.m.s.-responding (slow attack), depending on setup.

In addition to M/B Drive, the M/B Leveling Attack and M/B Leveling Release controls affect the slow leveling action, and are another factor affecting how the total gain reduction in the Multiband section is divided between the functions of leveling and compression.

**Leveling Attack**

M/B Leveling Attack must be set fast enough to control the maximum gain reduction in the Compressor, but not so fast as to abruptly ‘knock holes’ in the program. Unlike the Compressor, the Leveler has fairly slow release times, which can be very audible as a frequency response anomaly.

If M/B Leveling Attack is set too slow (higher number), the following stage is likely to over compress and impart a ‘muddiness’ or ‘mushiness’ to the program, especially at the beginning of a track when the overall level is increasing. If M/B Leveling Attack is set too fast (lower number), Leveler action will be audible as a sudden loss of energy in that band.

Begin with M/B Leveling Attack set to an average of about 15. It is a good idea to set the attack slower (higher numbers) at the low frequencies, and faster (lower numbers) at the high frequencies.
**Leveling Release**

M/B Leveling Release controls must be set fast enough to keep the Compressor in its optimum range when the level in a particular band gets low, but slow enough that the entire signal does not sound too ‘packed’ or ‘mushy,’ lacking in definition.

If M/B Leveling Release is too slow (higher number), the symptom of an individual band will be a lack of compression; that is, a quiet or insubstantial sound in that band, especially during the fade-out of a track when the overall level is decreasing. If M/B Leveling Release is set too fast (lower number), the symptom will be the ‘packed’ or ‘mushy’ sound described earlier.

Begin with all the M/B Leveling Release controls set at about 19. We have not yet found any use in setting release times faster than 18, or slower than 20, so be careful in venturing outside this range.

**Compression Time Constants**

As with other audio processing functions, the selection of compression time constants calls for a tradeoff between distortion and density, or loudness. Two types of distortion are manifested in compression, ‘confusion’ or ‘packing’ distortion, which is mainly affected by release timing, and ‘tearing’ or ‘harshness,’ which is primarily a function of attack timing.

In the Low band the tradeoff may not be obvious. Making the M/B Compression Attack slower (a higher number) will generally favor impulse sounds, such as kick-drum, over the more constant sounds of a bass guitar or bass synthesizer. Faster attack timing has the opposite effect. In general, fast attack times may also sound better on radios with small speakers, whereas slower times may sound better on bigger speakers.

For the Low band, start with a M/B Compression Attack setting of 9 or so for pop music, and a M/B Compression Release setting between 12 and 15. A setting of 12 might sound unnatural on large monitor speakers, but may sound better on small radios. 13 is a good compromise for L band release.

In the other three bands (Low-Mid, High-Mid and High), the tradeoff between density/loudness and distortion is more immediately apparent.

Begin with M/B Compression Attack time settings of 7, speeding them up (lower number) to reduce ‘harshness’ distortion, or slowing them down (higher number) to get more loudness in the band in question.

Begin with time settings of 14. Set a faster release (lower number) to get more output from the band in question. This will yield greater density and loudness at the expense of a more ‘packed’ sound. A slower release (higher number) will give a more open and natural sound at some sacrifice in density/loudness.

Going to an M/B Compression Release figure below 13 will give noticeable distortion on some tracks. Judging from the distorted air sound typical in major markets, you might consider a setting of 12 suitable for aggressive processing of pop music. A number of 11 or...
less makes the Compressor a virtual clipper and will sound quite harsh.

**NOTE:** Other processing equipment manufacturers generally do not provide as comprehensive control over limiter time constants. Make these adjustments with care! This is ‘where the rubber meets the road,’ so to speak, and you can really get ‘sonically unglued’ if these adjustments are not made with extreme caution. If in doubt, stick with the factory settings here.

The sonic tradeoff in the Wideband Limiter section is almost exactly as described for the Multiband Compressor. As the controls affect the whole frequency spectrum in this case, adjustment results are more immediately apparent. Much of the foregoing discussion covering Multiband Compression also applies to the Wideband Limiter.

The Wideband Limiter has a more complicated time constant structure, with two attack times and two release times. Peak limiting makes use of shorter time constants. The second set of longer time constants is based more on average level and defines a ‘platform’ upon which the peak limiting ‘floats.’

To become familiar with the operation of the platform limiting function, perform the following ‘get acquainted’ exercise.

1) Select one of the Medium formats and set Wideband Limiter Drive to 7dB. Set all the Wideband Limiter Time Constants sliders in the middle of their ranges; say 8, 14, 13 and 17.

2) Observe the W (Wideband) Limiting gain reduction meter. It is easy to see the fast peak and the slower platform time constants operating independently.

3) Leaving the other controls alone, experiment with the Plat Att (Platform Attack) slider. Allow a few seconds for each adjustment to take full effect. You should find that this control is handy for distributing the amount of gain reduction between the peak and the platform limiting functions and, in fact, acts as a ‘master tradeoff’ adjustment between loudness and quality, with the other controls remaining at their mid-positions.

Here are some additional Limiter setup hints, including a brief description of possible quality-degrading artifacts associated with each control:

1) Begin with a Pk Att (Peak Attack) setting of 7. Slow it down (with a higher number) for more loudness and ‘punch,’ at the expense of distortion, or speed it up (with a lower number) to clean up the sound at some loudness sacrifice. This works in concert with Pk Rel (Peak Release) time, and to some extent a slower attack time can be compensated for by making the release time slower as well (and vice-versa).

If Pk Att (Peak Attack) is set too slow (too high a number on the slider), there will be excessive overshoot, which will have to be
clipped. This will result in audible distortion, especially if Limit Drive is set at +4dB or above.

2) The normal Pk Rel (Peak Release) range is between 13 (loudness oriented) and 15 (quality oriented). If it is set too fast (low number), there will be too much of various types of distortion, such as ‘raggedness’ and ‘packing,’ or loss of definition. A setting of 12 gives a very loud sound and also boosts perceived high frequency content due to the small amount of distortion produced. 12 should be the upper limit of Pk Rel timing, unless you intentionally want to imitate the sound of the ‘dirtier’ processing by other stations in your market.

3) As mentioned earlier, the Plat Att (Platform Attack) time is particularly important as it acts as a master control for how the total program energy is divided between the peak and the platform limiting sections. Devote a fair amount of time to this control after the other Wideband Limiter time constants are set. The final setting will normally be in the range of 11 to 13, although this will depend on how all the other controls, including Wideband Limiter Drive, have been set.

Watch the W (Wideband) Limiting gain reduction meter and listen carefully as you make adjustments. As a rule of thumb, always try to have at least some energy in the platform section and some in the peak section of the Limiter. At low Limiter Drive levels, platform attack time has to be faster (lower numbers) to get energy into the platform than it does at higher Limiter Drive figures.

4) Plat Rel (Platform Release) will have a major effect on overall loudness if there is significant gain reduction (3dB or more) in the platform portion of final limiting. A setting of 17 is a median setting for this function. Faster times (lower numbers) will always sound louder, but can increase ‘mush,’ ‘packing’ and, indirectly, ‘tearing’ sounds. A setting of 18 is safe, but not very loud, and we have found that 16 and 17 can create audible ‘pumping’ if the other Wideband Limiter time constants are not set properly. 15 is an odd figure in that it generally sounds unobtrusive. We think this is due to a setting of 15 actually fooling the ear, tracking the program at the syllabic rate common to most pop music.

**High Frequency Limiter Time Constants**

HF Attack time should almost always be set to 8 for medium and aggressive formats, and to 6 or 7 for other applications. The slower the attack (the higher the number), the brighter the sound will be, but at the expense of increased HF distortion. (HF distortion comes across as a ‘sizzling,’ a ‘tearing,’ or excessive shrillness.) A setting of 9 would produce a laser-bright sound, though invariably there will be noticeable HF distortion, but probably no worse than most other processors in the market.

HF Release has to be set in conjunction with HF Attack. The faster the release (the lower the number), the brighter the sound but with
probable distortion. A setting of 12 works well for nearly any application.

Adjust With Care

The instructions, hints and caveats given in this Section of the Manual were developed after considerable field testing of the Omega_FM in a variety of markets, with a multiplicity of broadcast formats, and under a wide range of studio practices and working conditions. It is not our aim to tell you how to sound, only to help you get the sound you want.

By all means experiment with Omega_FM's comprehensive control over processing parameters, only please listen to what you do, and not on just one radio or one set of monitor speakers. It is our experience that the Omega_FM can be made to sound as good (or as bad!) as any processing system on the market today, and with a little time-well-spent it will sound better!

SAVING CUSTOM PRESETS AND MANAGING FILES

Changes to the factory processing presets, or any setup developed from scratch, can be saved in any one of three, user-defined Custom non-volatile memories internal to the Omega_FM. These are identified by front panel designations, and from within the Omega_FM software program, as Custom/Light, Custom/Medium and Custom Heavy.

NOTE: The names assigned to the three Custom (user-defined) memories simply distinguish one from another. Whether Custom/Heavy is actually more aggressive than Custom/Light is entirely dependent upon how you have programmed the setup saved there. The Omega_FM does not automatically make any modifications on its own based on the names of the memories.

Saving Setups

Once you have achieved a particular sound you like, your setup may be saved to one of the three Custom memories. Once you change any single processing parameter, if you then attempt to change formats through the Control→Format command, or try to exit the Omega_FM software program, this warning box will appear:
Clicking Cancel will lose any changes you have made, and either execute the next format selection or exit the program, depending on what you attempted. Clicking any of the three Custom buttons, however, will save your processing setup to that memory. The setup can be recalled at any time using a Control→Format software command or the front-panel buttons when the program is not running.

Alternatively, you can right-click in the Control→Format panel to bring up the options shown at right.

Using Save To (as shown) the setup that is currently running can be saved to any of the three Custom memories.

Saving to any Custom memory overwrites whatever was previously held there. Hence the need for some form of file management, conveniently provided in the Omega_FM software.

Note the two Download and the two Upload options. When a user-defined processing preset is saved to one of the Custom memories, it is immediately placed only in the Omega_FM’s internal, non-volatile memory, not as a file on the PC’s hard drive. To save the preset as a file in the Omega_FM software folder, it must be downloaded to the computer per the following steps.

Managing The “Custom” Format Files

Click on Download Custom To PC and select the Custom format you have created and wish to save as a file on the PC. This brings up the Save As box (shown at right). Type a name into the File name box and click Save. The .fmt extension will automatically be added. You may save any number of user-defined formats in this file.
The Upload Custom From PC command allows you to place any single, saved PC file into any one of the Custom memories internal to the Omega_FM; all three Custom memories may be updated one-at-a-time. Click Upload Custom From PC, choose the destination, ‘Custom’ memory slot, select a file for transfer (as shown at right), then click Open.

Remember only three Custom processing presets can be resident in the Omega_FM at a time, though any user-defined format, which has been saved in the computer per the preceding procedure, may be uploaded to replace any Custom file as required.

**Managing “All” Format Files**

**WARNING:** The file labeled format36.fmt is the file of factory presets, including default, ‘filler’ presets for the three Custom memories. Be sure not to delete or overwrite this file. If this happens, software will have to be reinstalled.

Referring back to the upper screen image on Page 57, note the two file management options: Download All To PC and Upload All From PC. This allows saving all twelve presets (the three Custom presets and the nine factory presets) in one operation.

This utility operates in an identical manner to the management of individual files as explained above. The file labeled format36.fmt is the file of all factory presets, including default, ‘filler’ presets for the three Custom choices. As the Custom memories in the Omega_FM are updated with user-defined presets, the entire family of setups, which includes the factory setups, may be downloaded to the computer as a ‘master’ processing setup file. This process uses the Download All To PC command, naming the file something that reflects the more “global” nature of the file contents, such as KJIM1.fmt or 2-16-02.fmt. Consider this a ‘safety’ copy of all the formats in the Omega_FM, or a library of all presets that could be taken to another facility. Such a ‘safety’ or ‘transport’ file can be put on a floppy disk if need be. Using the Upload All From PC utility at a second installation, these setups could be transferred quickly to another Omega_FM.

**An Example**

The following example may further clarify this somewhat copious process.

Say you have developed and have individually uploaded the three user-defined formats in our example above. GM’s nighttime choice.fmt, PD Bob’s favorite.fmt and Melt The Radio.fmt have been uploaded into the Custom Light, the Custom Medium and the Custom Heavy slots in the Omega_FM, respectively. Now the Omega_FM has these resident in its non-volatile memory.
First we’ll use the Download All To PC command and type-in a name for the new file, something like: KBOB 6-12-02 processing might best represent the station’s processing setup preferences as of a certain date. This file will contain all factory presets, plus our three Custom setups.

Next we click Save. The Progress bar will indicate the transfer of the entire family of processing setups from Omega_FM memory to the new ‘master’ file in the computer.

If we now were to invoke the Upload All From PC command, this screen would pop up. Here the new, all-inclusive ‘master’ file is selected and highlighted. If we were to click Open, the files would be uploaded back to the Omega_FM... redundant in this case, but useful for updating a second processor or restoring a lost file.

Keep in mind that our new KBOB 6-12-02 processing ‘master’ file also contains our three Custom files. These are also .fmt files, but only a .fmt file that contains the factory presets, such as our new ‘master’ file, can be uploaded to the Omega_FM under the Upload All From PC command. Attempting to upload single files under this command will give an error message.

Management of Omega_FM firmware is given on Page 23 in Section IV.
Full 2-way remote control of the Omega FM requires use of a US Robotics external modem or the identical technical equivalent. You will need to provide a 25-pin to 9-pin standard modem cable (not a ‘null modem’ cable) to connect the modem to the Omega FM.

**NOTE:** When the Omega FM is under modem remote control, it will not respond to local computer commands so long as the dial-up connection is active. Additionally, should the modem receive a call while a local computer is connected, the local computer connection will be dropped immediately. If you are working at a remote site with an Omega FM under modem remote control, you may wish to unplug the telephone line temporarily to avoid possible interruption of your local adjustments or uploads.

Processing commands communicated via modem override any dayparting schedule in effect.

**CONNECTING THE MODEM**

**Recommended Modem**

Initial setup of the modem, if required, utilizes the Modem Setup utility under on the main Omega FM screen. This utility allows communication between the controlling PC and the external modem through the Omega FM.

Any external modem should work with the Omega FM. Nevertheless, we heartily recommend, without reservation, any current US Robotics (56K/V.90 “fax type”) modem for dial-up remote control. No one at Inovonics got a week in Hawaii, courtesy of US Robotics; we make this recommendation because the Omega FM is fully compatible with this modem, just as it comes from the manufacturer, with all the default factory settings. Even the setup software disk supplied with the modem can be ignored.

It is not within the scope of this Manual to detail the requisite tests and to provide subsequent instructions for any of the plethora of external modems that are commonly available. Nevertheless, as factory and field experience with different external modems increases, any useful information will be posted to the Inovonics Website, www.inovon.com.

Next, connect the modem to the Omega FM with the 25-pin to 9-pin (standard) modem cable, and connect the modem to the telephone jack.
Clicking Setup→Modem Setup and entering the Super Password will bring up the screen shown here. With external modems that are not fully US Robotics-compatible, setup instructions may be entered on the Command line. After a command string is entered, clicking the Execute button will send the command to the modem. The Result window will then display information sent back by the modem.

All compatible external modems respond to the Hayes AT Command Set. Individual modems may require unique commands, but some commands are universal to all. Documentation that comes with the modem will list default setup options, as well as instructions for alternate setup choices, such as baud rate and number of rings before pickup.

One diagnostics command that should work with any viable modem is ATI6 (capital ‘A’, capital ‘T’, capital ‘I’ and the number 6). Typing this into the Command box will return make, model and other hardware information, as well as recent communication history.

Here, a connected, yet idle US Robotics modem has been interrogated with the ATI6 command.

**SETTING UP COMPUTER COMMUNICATIONS**

Setting up the computer’s internal modem for communication with the Omega_FM uses another utility that can be reached from the main Omega_FM screen.
Click Remote to bring up the Connect screen. This screen is used to initiate the dial-out connection to the external modem connected to the Omega_FM, and also for setting up the computer’s internal modem for communications.

Next, click Setup to display the screen shown below.

A basic ‘default’ modem setup routine is included with the Omega_FM software. This initially appears under Modem Commands on the left side of the Modem Setup screen.

Omega_FM software automatically detects the setup routine for the computer’s internal modem. This appears on the right side of the screen under Manufacturer Modem Commands. If the computer has more than one internal modem installed, the two scroll buttons above the OK may be used to bring the command set for modem into view.

The default setup is provided simply as a starting point when the entire setup string must be entered manually. Unless the computer’s internal modem is exceedingly stupid, this should never be necessary. Therefore simply click the Use button at the bottom of the Manufacturer Modem Commands panel to transfer the detected settings to the ‘working’ left-hand panel. An example of this operation is shown at the top of the next page.
Make note of the three circled items. These are discussed below.

**Port Assignment**

Software may, or may not, recognize the computer port that is assigned to the internal modem. If this blank is empty, follow this procedure to determine which port to assign.

From the main Windows screen, click Start → Settings → Control Panel, then double-click the System icon. This will bring up the System Properties box. Click and view the Device Manager.

Find and highlight the computer’s internal modem, then click on Properties.

In the Modem Properties box, click Modem and make note of the assigned port. In this example it is COM4. This must be typed into the Port blank in the Omega_FM Modem Setup panel, shown empty at the top of this page. Be sure to type this in exactly as shown in the Windows Modem Properties box; that is, all caps with no spaces.

**Modem Communication Speed**

Note the area circled in the Init #2 box at the top of the page. Among other things, this setup string describes the connection speed between the internal modem and the external, dial-up modem connected to the Omega_FM.
The connection speed value (this is the number that follows the letter W) must be set to a figure other than 0 (zero) for bargraph metering to show reliably and consistently on the computer screen. If this number is 0 (zero), edit the entry and change the 0 to a 1 (one). In the example shown, the original figure was not a zero, it was a 3, so it was left alone.

**Phone Number**

Enter the telephone number for the remote Omega_FM location in the Phone Number blank. Be sure to include all dialing codes, including any special codes to disable call waiting, etc. If the computer must first dial a ‘9’ to access an outside line, the appropriate pause can be added by typing one or more commas where the pause is required.

Click OK to close the Modem Setup screen. This will return you to the Connect screen. Simply click Connect to dial the Omega_FM, and Disconnect to terminate the connection. Progress of the call will be displayed in the area to the left of the buttons.

Once connected, modem control will be identical to direct computer control of the Omega_FM, save for small delays in command execution. Use the Hide button to remove the Connect screen during operation.
Appendix

The following pages contain miscellaneous documentation that may prove useful in the operation and the maintenance of the Omega_FM.

**Processor Setup Worksheets**
A multi-redundant, non-volatile floppy memory (in the form of several blank copies of a hardcopy worksheet) has been included in this Appendix. These sheets are for manual entry of processor settings. The sheet is arranged so that each variable parameter may be written down for later reference. Save one of the blanks as a master and make additional photocopies as propriety demands (no ‘dongle’ required).

**SBC Jumper Positions**
The Single Board Computer (SBC) used in the Omega_FM has a myriad of connectors and several jumpering options. On Page 9 of this Manual we supplied a caveat regarding SBC jumpers, urging the user to leave them alone. Anticipating, however, that some users will be sorely tempted to perform a “what if...” experiment despite any warnings, expressed or implied, we have included a drawing of this board that shows proper jumper placement for normal operation.

**Inovonics Warranty**
The terms and conditions of Inovonics’ generous Warranty are printed on the inside of the back cover of this Manual.
# Inovonics Omega FM Processor Setup Worksheet

**Date** | **Time** | **Operator**
---|---|---

**Format Name**

**File Name/Location**

Uploaded to Omega as Custom / [ ] Light [ ] Medium [ ] Heavy

## AGC

<table>
<thead>
<tr>
<th>Gate Thresh</th>
<th>-</th>
<th>dB</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary AGC Time Constants</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attack</td>
<td>Release</td>
<td>Rest Rate</td>
</tr>
<tr>
<td><strong>Advanced AGC Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max Gain</td>
<td>dB</td>
<td>Fast Att Th</td>
</tr>
</tbody>
</table>

## PARAMETRIC EQ

<table>
<thead>
<tr>
<th>Section</th>
<th>Freq</th>
<th>Q</th>
<th>Amp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hz</td>
<td>dB</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Hz</td>
<td>dB</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Hz</td>
<td>dB</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Hz</td>
<td>dB</td>
<td></td>
</tr>
</tbody>
</table>

**Artist’s Rendering?** ▶

**EQ Notes:**

## MULTIBAND LEVELER / COMPRESSOR

<table>
<thead>
<tr>
<th>MB Drive</th>
<th>dB</th>
<th>Lev. Gate Threshold</th>
<th>-</th>
<th>dB</th>
<th>Lev. Gate Rest Level</th>
<th>-</th>
<th>dB</th>
<th>Bass Enhance</th>
<th>dB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>dB</td>
<td></td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Mid</td>
<td>dB</td>
<td></td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High Mid</td>
<td>dB</td>
<td></td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High</td>
<td>dB</td>
<td></td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## LIMITER

<table>
<thead>
<tr>
<th>WB Limit Drive</th>
<th>dB</th>
</tr>
</thead>
<tbody>
<tr>
<td>HF Limiter Balance</td>
<td>Peak Attack</td>
</tr>
<tr>
<td>HF (50) WB</td>
<td>Platform Attack</td>
</tr>
</tbody>
</table>

**HF Limiter Time Constants**

**Pre-Emphasis** | µs | HF Attack | HF Release |

## MPX

<table>
<thead>
<tr>
<th>MPX Clip</th>
<th>dB</th>
<th>Clipping Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Raw</td>
</tr>
</tbody>
</table>

**Additional Notes:**
## Inovonics Omega_Fm Processor Setup Worksheet

**Date**

**Time**

**Operator**

<table>
<thead>
<tr>
<th>Format Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

**File Name/Location**

- [ ] Light
- [ ] Medium
- [ ] Heavy

**Uploaded to Omega as Custom**

### AGC

<table>
<thead>
<tr>
<th>Gate Thresh</th>
<th>Primary AGC Time Constants</th>
</tr>
</thead>
<tbody>
<tr>
<td>dB</td>
<td>Attack</td>
</tr>
</tbody>
</table>

**Advanced AGC Settings**

<table>
<thead>
<tr>
<th>Max Gain</th>
<th>Fast Att Th</th>
<th>Fast Rel Th</th>
<th>Fast Att</th>
<th>Fast Rel</th>
</tr>
</thead>
<tbody>
<tr>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
</tr>
</tbody>
</table>

### PARAMETRIC EQ

<table>
<thead>
<tr>
<th>Section</th>
<th>Freq</th>
<th>Q</th>
<th>Amp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
<tr>
<td>2</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
<tr>
<td>3</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
<tr>
<td>4</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
</tbody>
</table>

**Parametric EQ Graph**

**EQ Notes:**

- Artist’s Rendering?

### MULTIBAND LEVELER / COMPRESSOR

<table>
<thead>
<tr>
<th>MB Drive</th>
<th>dB</th>
<th>Lev. Gate Threshold</th>
<th>Lev. Gate Rest Level</th>
<th>Bass Enhance</th>
<th>dB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
</tr>
<tr>
<td>Low Mid</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
</tr>
<tr>
<td>High Mid</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
</tr>
<tr>
<td>High</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
</tr>
</tbody>
</table>

### LIMITER

<table>
<thead>
<tr>
<th>WB Limit Drive</th>
<th>dB</th>
<th>Wideband Limiter Time Constants</th>
</tr>
</thead>
<tbody>
<tr>
<td>HF Limiter Balance</td>
<td>Peak Attack</td>
<td>Peak Release</td>
</tr>
<tr>
<td>HF (50)</td>
<td>WB Platform Attack</td>
<td>Platform Release</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HF Limiter Time Constants</th>
</tr>
</thead>
</table>

### MPX

<table>
<thead>
<tr>
<th>MPX Clip</th>
<th>dB</th>
<th>Clipping Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>[ ] Raw</td>
</tr>
</tbody>
</table>

**Additional Notes:**

--- 67 ---
Inovonics Omega_FM
Processor Setup Worksheet

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Operator</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Format Name</th>
<th>File Name/Location</th>
<th>Uploaded to Omega as Custom</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Light</td>
</tr>
</tbody>
</table>

### AGC

<table>
<thead>
<tr>
<th>Gate Thresh</th>
<th>Primary AGC Time Constants</th>
</tr>
</thead>
<tbody>
<tr>
<td>– dB</td>
<td>Attack</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Advanced AGC Settings**

<table>
<thead>
<tr>
<th>Max Gain</th>
<th>Fast Att Th</th>
<th>Fast Rel Th</th>
<th>Fast Att</th>
<th>Fast Rel</th>
</tr>
</thead>
<tbody>
<tr>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
</tr>
</tbody>
</table>

### PARAMETRIC EQ

<table>
<thead>
<tr>
<th>Section</th>
<th>Freq</th>
<th>Q</th>
<th>Amp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
<tr>
<td>2</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
<tr>
<td>3</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
<tr>
<td>4</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
</tbody>
</table>

**Parametric EQ Graph**

EQ Notes:

**Artist’s Rendering?**

### MULTIBAND LEVELER / COMPRESSOR

<table>
<thead>
<tr>
<th>MB Drive</th>
<th>lev. Gate Threshold</th>
<th>Lev. Gate Rest Level</th>
<th>Bass Enhance</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>– dB</td>
<td>– dB</td>
<td>dB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Mid</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>High Mid</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>High</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### LIMITER

<table>
<thead>
<tr>
<th>WB Limit Drive</th>
<th>Wideband Limiter Time Constants</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Peak Attack</td>
</tr>
<tr>
<td>HF Limiter Balance</td>
<td>Platform Attack</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HF (50)</th>
<th>WB</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**HF Limiter Time Constants**

<table>
<thead>
<tr>
<th>Pre-Emphasis</th>
<th>µs</th>
<th>HF Attack</th>
<th>HF Release</th>
</tr>
</thead>
</table>

### MPX

<table>
<thead>
<tr>
<th>MPX Clip</th>
<th>Clipping Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>dB</td>
<td>Raw</td>
</tr>
</tbody>
</table>

**Additional Notes:**

---
Inovonics Ωmega_FM
Processor Setup Worksheet

Date       Time       Operator

Format Name
File Name/Location
Uploaded to Omega as Custom / □ Light □ Medium □ Heavy

AGC

<table>
<thead>
<tr>
<th>Gate Thresh</th>
<th>dB</th>
<th>Primary AGC Time Constants</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Attack</td>
</tr>
</tbody>
</table>

Advanced AGC Settings

<table>
<thead>
<tr>
<th>Max Gain</th>
<th>dB</th>
<th>Fast Att Th</th>
<th>dB</th>
<th>Fast Rel Th</th>
<th>dB</th>
<th>Fast Att</th>
<th>Fast Rel</th>
</tr>
</thead>
</table>

PARAMETRIC EQ

<table>
<thead>
<tr>
<th>Section</th>
<th>Freq</th>
<th>Q</th>
<th>Amp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
<tr>
<td>2</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
<tr>
<td>3</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
<tr>
<td>4</td>
<td>Hz</td>
<td></td>
<td>dB</td>
</tr>
</tbody>
</table>

Artist’s Rendering?

EQ Notes:

MULTIBAND LEVELER / COMPRESSOR

<table>
<thead>
<tr>
<th>MB Drive</th>
<th>dB</th>
<th>Lev. Gate Threshold</th>
<th>Lev. Gate Rest Level</th>
<th>dB</th>
<th>Bass Enhance</th>
<th>dB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td></td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
</tr>
<tr>
<td>Low Mid</td>
<td></td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
</tr>
<tr>
<td>High Mid</td>
<td></td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
</tr>
<tr>
<td>High</td>
<td></td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
<td>dB</td>
</tr>
</tbody>
</table>

LIMITER

<table>
<thead>
<tr>
<th>WB Limit Drive</th>
<th>dB</th>
<th>Wideband Limiter Time Constants</th>
</tr>
</thead>
<tbody>
<tr>
<td>HF Limiter Balance</td>
<td>Peak Attack</td>
<td>Peak Release</td>
</tr>
<tr>
<td>HF</td>
<td>(50)</td>
<td>WB</td>
</tr>
<tr>
<td>Platform Attack</td>
<td>Platform Release</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HF Limiter Time Constants</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Emphasis</td>
</tr>
</tbody>
</table>

MPX

<table>
<thead>
<tr>
<th>MPX Clip</th>
<th>dB</th>
<th>Clipping Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Raw</td>
</tr>
</tbody>
</table>

Additional Notes:
Single-Board Computer
Jumpering Options

This sketch identifies the factory-default locations for various jumpers on the SBC (Single-Board Computer), the primary digital processing 'engine' of the Omega_FM.

These jumpers have not been identified as to their function. The jumper positions shown are the only options for proper operation of the Omega_FM.
INOVONICS WARRANTY

I  TERMS OF SALE:  Inovonics products are sold with an understanding of “full satisfaction”; that is, full credit or refund will be issued for products sold as new if returned to the point of purchase within 30 days following their receipt, provided that they are returned complete and in an “as received” condition.

II  CONDITIONS OF WARRANTY:  The following terms apply unless amended in writing by Inovonics, Inc.

A. The Warranty Registration Card supplied with this product must be completed and returned to Inovonics within 10 days of delivery.

B. This Warranty applies only to products sold “as new.” It is extended only to the original end-user and may not be transferred or assigned without prior written approval by Inovonics.

C. This Warranty does not apply to damage caused by misuse, abuse, accident or neglect. This Warranty is voided by unauthorized attempts at repair or modification, or if the serial identification label has been removed or altered.

III  TERMS OF WARRANTY:  Inovonics, Inc. products are warranted to be free from defects in materials and workmanship.

A. Any discrepancies noted within ONE YEAR of the date of delivery will be repaired free of charge, or the equipment will be replaced with a new or remanufactured product at Inovonics’ option.

B. Parts and labor for factory repair required after the one-year Warranty period will be billed at prevailing prices and rates.

IV  RETURNING GOODS FOR FACTORY REPAIR:

A. Equipment will not be accepted for Warranty or other repair without a Return Authorization (RA) number issued by Inovonics prior to its return. An RA number may be obtained by calling the factory. The number should be prominently marked on the outside of the shipping carton.

B. Equipment must be shipped prepaid to Inovonics. Shipping charges will be reimbursed for valid Warranty claims. Damage sustained as a result of improper packing for return to the factory is not covered under terms of the Warranty and may occasion additional charges.

Revised Oct. 2001